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Introducing the Theme Editor
Since the release of SONAR X1, Cakewalk has used a user interface dubbed "Skylight". Cakewalk now includes a Theme Editor that 
allows us to modify colors and images used in the Skylight interface, to create our own "skin" or "theme".

The dimensions and layout of the images can not be changed; and there are some inter-dependencies that limit our scope to create a 
completely customized look-and-feel, but despite this, we have the power to create a wide variety of themes for Cakewalk. 

Folks have been creating custom themes for some time, and there is an entire forum dedicated to theming on Cakewalk's discussion 
web site: https://discuss.cakewalk.com/index.php?/forum/31-ui-themes/

The Cakewalk Theme Editor displays a hierarchical list of elements (colors and images) that we can change and replace.  Some of these 
elements are very obvious in their form and function; however others are more cryptic or overloaded with multiple effects, or have 
changed over time as the Cakewalk application has evolved and improved.

Some of the color values are impossible to determine by name alone, and some are even miss-named. Other elements don't appear to 
be used at all: they are either obsolete, or perhaps reserved for future use.

Creating a complete Cakewalk Theme is challenging. There's so much detail, and sometimes it is very difficult to find the right item to 
change in the Theme Editor. 

Some sort of illustrated guide seemed to be in order.
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Concerning Color Preferences
You don't NEED to understand color preferences in order to prepare a customized Theme for Cakewalk, but it helps if you want to 
squeeze the final 10% out of the customiziing possibilities.

Would that 'twere so simple
Before the Theme Editor, there were Color Preferences. Actually, there still 
are Color Preferences. And they are used alongside Themes in rendering the 
Cakewalk user interface.

Some history: Back in the day, Cakewalk allowed some colors used in the 
SONAR application to be customized by the user, and saved as presets. 
Some default presets were supplied out-of-the-box.

When Cakewalk SONAR X1 was released, the UI was revamped considerably 
(known as the "Skylight" interface) and many of these color preferences 
stopped working. If memory serves, over time a few of them were restored 
and others were left as obsolete or unused.

When you export a color preference preset as text .CLR file, you can edit it 
and see there are a total of 295 possible settings, although only 167 of them 
are exposed in the Preferences > Colors editor. 

The color settings are saved as numeric base10 values, where 00 00 00 = 0 
and FF FF FF = 16777215.

Warning: When you import a .clr file, it overwrites the current preset and 
marks it as "unsaved". Remember to save it with a new name!

You can read about the Preferences > Colors feature in the documentation.

How does Cakewalk decide which color to use?
How Color Preferences interact with customized theme elements can be confusing, but the sequence for determining a UI element's  
color appears to be as follows:

• Use the default (Mercury?) color, unless:

• There is an appropriate color preference in the current preset (e.g. Normal, Bright, Mono, etc), unless:

• There is an appropriate custom element in the current Theme (e.g. Tungsten), unless:

• There is an appropriate customized (non-default) color preference 

Given the way the color customization features in Cakewalk have been developed and refined and changed over time, I don't think you 
can rely 100% on that process determining the color. 

There may be UI elements where:

• there is no corresponding color preference setting;

• there is no corresponding Themable element;

• the default color preference setting is just ignored;

• the custom theme element is ignored;

• the color preference setting is always used (even when a theme says otherwise)

There are some UI elements that can not be changed in the Theme Editor, but do have a corresponding Color Preference. In order to 

provide a fully-themed experience to your users, you may have to provide both a custom theme (.STH) file and an exported color 
preference preset (.CLR) file.
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Example 1: Track View Ruler:

The default user interface, using the default "Normal" color 
preference preset:

Now selecting a custom Theme "Colored Ruler" that changes the 
ruler background, the Marker color, and the Ticks and Digits as seen 
here:

Going into Color Preferences, setting Marker to blue and Digits to orange, saving as "Normal Modified" preset: 

Because "Normal Modifed" has default color settings for Ruler Background and Tick Marks, these are unchanged, and continue to take 
their settings from the current Theme.

Switching themes to "Flat White":

The marker and digits continue to use the two customized  color 
preferences.

Now switching back to Color Preference preset "Normal":

Now all the elements are taking their color from the custom Theme.

Example 2: Clip Fade curve

Consider the Flat White custom theme, which uses light-colored clip backgrounds. Notice that the clip fade curves are perhaps not as 
visible as we'd like:

However, under Preferences > Colors we can change the Clip Fade setting:

And now we see:
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1. Skylight UI

Global / Sizing Bar Background 
This element affects the resizing bars between the multidock, and other side-docked windows:

Also used in:
Multi-dock tab separators

Global / View Border
Borders of the main view windows use this element:

Also used in:

1.1. Multi-dock tab 3D shading

4. Browser window background

6. Inspector window frame sides

12. Staff view toolbar background

13. Synth Rack view window background
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Global / Dock
Global / Undock
Global / Drop
Global / Dockbar Right
Global / Dockbar Left
Global / Dockbar Up
Global / Dockbar Down
These seven items are used in several places throughout the Skylight UI for showing and hiding panels:

Global / Menus / View Menu Text 
This controls docked window titles:

Also used in:

1.2 multiple views’ top menu text

3. Track view Ripple Edit menu text

4. Browser drop-down menu text

7. ProChannel header text, and value text

13. Synth Rack view drop-down menu text

15. Loop Contruction view toollbar label text

16. Event List view column header title text

20. Markers view column title text

Global / Menus / MenuBar Gradient Start 
Docked window title bar 3D gradient:

Also used in:

1.1. Multi-dock tab 3D shading

1.2. multiple views top menu 3D shading

Global / Menus / MenuBar Gradient End 
Docked window title bar 3D gradient:

Also used in:

1.1. Multi-dock tab 3D shading

1.2. multiple view top menu 3D shading
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Console view / Control Text and Values
This element is used for the text of collapsed docked windows:

Global / Scroll bars / Scroll Bar Background 
Global / Scroll bars / Scroll Bar Thumb 
Shown here using Pink and Green:

Note that the arrows in the left/right buttons are painted a darker shade of the "Scroll Bar Background" color. If you choose a dark color 
for the background, the button arrows may be hard to see.

@sjoens on the Cakewalk forum noticed that the Help Module
scroll bars do not follow this scheme exactly. The scroll background 
seems to be respected, but the "thumb" and "arrow" can be colored 
unexpectedly. Here, with a pale pink background, the other elements 
seem to use a darker shade of the background color.

But other colors can have startlingly different results, as shown
on the right.

Global / Scroll bars / Zoom In
Global / Scroll bars / Zoom Out

Global / Zoom Fader

Global / Zoom Horizontal Background 
Global / Zoom Vertical Background 
Clicking on the Zoom Fader icon brings up...  the Zoom Fader, using either the Horizontal or Vertical Background image:
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Global / Lenses dropdown menu
The "Lenses" feature is now called "Workspaces":

Global / Full Screen toggle
Image strip of five 20x20 icons. 

States:

1. Initial default state (not Full-screen)
2. unused?
3. Mouse over/hover ?
4. In Full Screen (press to restore)
5. unused?

Curious Fact: There appears to be some visual glitches in how these images are applied, that aren't normally visible when using the 
default image strip. Using the numbered version shown here, as soon as I move the mouse over the toggle, the image changes:

When the window next re-draws (like, switching applications) the toggle icon returns to State (1). When maximized, State (4) is used, 
but there is no mouse-over effect. 

In practice, this is not important at all. I just found it interesting.

Global / Wallpaper
This theme element is used as the wallpaper for the parent window. Normally only seen when the application first opens, or if the child 
windows are not maximized:

Global / Alternative Color #1 Not yet identified
Global / Drop Indicator 
@StarshipKrupa located this one - it's the line that appears between tracks when dragging and dropping them:

Global / Enable/Disable Toggles Not yet identified
Global / Frame Rounded Corner Bottom Left No longer used
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Global / Frame Rounded Corner Bottom Right No longer used
According to @sjoens, these two are no longer used. They were the lower corners of TV's frame in X1 when more graphics were used.

1.1. Multi-Dock Tabs

Global / Menus / View Menu Text
Tab label text:

Also used in:

(other places - see complete list)

Global / Sizing Bar Background 
This element is used to divides the mult-dock tabs. In practice, anything other than a dark color doesn't seem to work so well visually:

Also used in:

Skylight window resizing bar

Global / Menus / MenuBar Gradient Start 
Multi-dock tabs:

Also used in:

(other places - see complete list)

Global / Menus / MenuBar Gradient End 
Multi-dock tabs top broder/separator:

Also used in:

(other places - see complete list)

Global / View Border
See the shading of unselected and selected tabs in the multi-dock:

Also used in:

(see complete list)
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1.2. Menus

Global / Menus / View Menu Text 
Multiple views’ top menu text (e.g. Track view, Piano Roll view, Staff view):

Also used in:

(see complete list)

Global / Menus / MenuBar Gradient Start 

Also used in:

(other places - see complete list)

Global / Menus / MenuBar Gradient End 

Also used in:

(other places - see complete list)

Global / Menus / MenuBar Border Light
Global / Menus / MenuBar Border Dark
Shown here using Yellow and Blue. You can see how these two color elements are used to decorate the menus, in various places in the 
UI:

Track View:

Tempo View:

Synth Rack:

Track view / Track View Menu Bar Background
Very hard to see, but located by Matthew White:
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1.3. Dialog Boxes

Global / Dialog Box Banner Text 
Global / Dialog Box Banner Background 
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1.4. Miscellaneous

Global / Track Color Picker / Background

Global / Track Color Picker / Color drop-down
Global / Track Color Picker / Other Color Empty
Global / Track Color Picker / Other Color Button

Global / About Box / Background

Global / About Box / ARA logo
Global / About Box / ReWire logo
Global / About Box / ASIO logo
Global / About Box / VST logo
Global / About Box / DXi logo
Global / About Box / Izotope Radius logo
These are visible if you click on the "Legal" button in the About Box:

Global / About Box / SoundCloud logo Probably Obsolete

1. Skylight UI Page  14



Global / Toast notifications / Cakewalk logo
Global / Toast notifications / Close button
Global / Toast notifications / Warning icon
Global / Toast notifications / Error icon

(ColorPref) Lasso Select
This is the shading color used when right-click-drag selecting. It works in Track View Clip Pane; Staff View, and Piano Roll View. 
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2. Control Bar

Global / Alternative Text #2
Used in the Custom; Screenset; Sync; Mix Recall; ACT; and Marker modules, as button or menu text:

Also used in:

3.4. Track view Track Strip drop-down menu text

2.2 Tools Module Note Size menu text

Track View / Unfocused Track Text
Control Bar Modules: value text (Transport, Loop, Selection, Punch, Inspector):

Note that this color is used in many places, some of which (e.g. Slider Control Value text; PRV Track Number text) must be visible on a 
dark/black background.  Therefore we are practically constrained to use a light color for this element.

Also used in:

2.4. Transport Module timeline slider

3.1. Track view Track Pane Header Now Time display text

3.2. Add Track Flyout

3.4. Track view Track Strips Track Control Value text

3.11. Track View Folder Header summary control labels and values

4.1. Media Browser filename list text

4.3. Notes Browser text

5.2. Console view Track Number/Hardware Output name text

7. ProChannel preset name text

9.1. Piano Roll view un-selected track text

10. Step Sequencer value text

12. Staff view un-selected track text

14. AudioSnap drop-down menu value text

15. Loop Construction view toolbar slider and value text

28. Help Module text

Control Bar / Background Fill Not yet identified

Control Bar / Cakewalk logo
Appears on the the right side of the bar.
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Control Bar / Go to First Module
Control Bar / Go to Previous Module
Control Bar / Go to Next Module

Control Bar / Go to Last Module
Applies to when the main window is narrower than the visible set of modules:

Control Bar / Go to First Module (collapsed)
Control Bar / Go to Previous Module (collapsed)
Control Bar / Go to Next Module (collapsed)
Control Bar / Go to Last Module (collapsed)
Same as above, only for "collapsed" control bar:

Control Bar / Scroll Fade
Transparent "fade out" appears when the Go to buttons are visible:

Control Bar / Background (collapsed)
Appears to be overlaid with the module's "collapsed background". Some kind of alpha-channel (transparency) is applied. In this case, a 
solid pink rectangle appears as:

Control Bar / Close
Only visible when the control bar is floating:

Control Bar / Scroll Go To Not yet identified
Control Bar / Collapsed Background Pop-up
Little up/down arrows, only used when the control bar is "collapsed":
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Control Bar / Left Border Grip
Not visible when control bar modules 
are"locked".

Control Bar / Left Border No Grip
Only applies when "Lock Module Order" is selected (not visible when justified or centered):

Control Bar / Collapsed Vertical Background

Control Bar / Collapsed Vertical Background Left Grip
Visible when the Control Bar is collapsed and not locked.

Control Bar / Collapsed Vertical Background Left
Only visible when Control bar is collapsed and locked:

Control Bar / Menu (wide)
Looks as though this is used in Sync, Mix Recall, ACT, and Marker modules:

Control Bar / Menu (medium)
Used by the Sync module when sized to "Small":

Control Bar / Menu (narrow)
Used in Mix Recall and ACT when modules are resized to "Small":
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2.1. Export module

Control Bar / Modules / Export / Background (large)
Control Bar / Modules / Export / Background (small)

Control Bar / Modules / Export / Background (collapsed)

Control Bar / Modules / Export / Menu Button (large)
Control Bar / Modules / Export / Menu Button (small)

According to the PURPLETRATOR test, "Export" will always be written in White. So we are constrained somewhat in our design choices.

Also, even though there are 5 slides in the element, only the first one is used. The button does not change when clicked, only the menu 
appears.

Control Bar / Radio Button
This theme element contains 8 "impressions", and their use according to @StarshipKrupa are:

1. Normal unselected

2. Pressed when unselected

3. Mouse-over when unselected

4. Selected

5. Pressed when selected

6. Mouse-over when selected

7. disabled / no project loaded

8. ? unknown

According to the PURPLETRATOR test, the "Project"/"Selection" text and duration value text colors are static and can't be changed.
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2.2. Tools module

Control Bar / Modules / Tools / Smart Tool
There are  five images in the button strip graphic, 34 x 34 pixels (x 5):

1. not selected but available
2. mouse down / clicked
3. mouse over / hover
4. selected (enabled)
5. not available / no project open

State [2] only appears very briefly (if at all) when left-mouse-clicked, before being replaced by State [1]

Control Bar / Modules / Tools / Smart Tool (customized)
Control Bar / Modules / Tools / Select tool
Control Bar / Modules / Tools / Move Tool
Control Bar / Modules / Tools / Edit Tool
Control Bar / Modules / Tools / Timing Tool
Control Bar / Modules / Tools / Comp Tool.png
Control Bar / Modules / Tools / Split Tool
Control Bar / Modules / Tools / Draw Tool
Control Bar / Modules / Tools / Pattern Tool
Control Bar / Modules / Tools / Line Tool
Control Bar / Modules / Tools / Sine Tool
Control Bar / Modules / Tools / Triangle Tool
Control Bar / Modules / Tools / Square Tool
Control Bar / Modules / Tools / Saw Tool
Control Bar / Modules / Tools / Random Tool
Control Bar / Modules / Tools / Erase Tool
Control Bar / Modules / Tools / Mute Tool

Track view / Focused Track Text
An unexpected use of Focused Track Text is the text on the draw note size menu in the Tools module, when Smart or Draw tools are 
active:

Also used in:

(other places - . see complete list)

Global / Alternative Text #2
This theme element is used for text in the note size menu when Smart or Draw tools are NOT active.

See also: Control Bar menu text
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Control Bar / Menu Button

This element has five impressions in the button stack. Which ones are actually used? Because the text is rendered using Focused Track 
Text, this may be a constraint. I've only ever seen Impression 4 (active) used here. (Impression 1 is used in the Tools HUD, see below.)

1. Tools HUD (see below); when Smart or Draw tools are not active

2. n/a

3. n/a

4. When Smart or Draw tools are active

5. No project loaded (disabled)

2.2.1 Tools HUD

Control Bar / Modules / Tools / Tools Module HUD background
Click the middle mouse button (or scroll wheel) to display the Head Up Display (HUD)  for the Tools module:

• The Edit Filter ("clips") element is Track view / Track Pane / Menu Button

• The resolution menu in the HUD is using Control Bar / Menu Button, impression 1

• If you click on the resolution button, it will momentarily change to impression 2 as it fades from sight.

• The text is italic. Why? Because.

Control Bar / Menu Button
@StarshipKrupa has this to say about how this element is used in the Tools HUD:

• Cell 1 is used when the Smart Tool or Draw Tool are not selected. 
This cell should be a color that will contrast well with the "default" white text color.

• Cell 2 is used on the HUD in that odd case where after you click on the duration menu, it flashes briefly as the HUD closes. It 
also acts as a "pressed" state button in the case where you have neither the Smart nor Draw Tool selected, but press on it. A 
brief flash again.

• Cell 3 is not used.

• Cell 4 is used when the Smart or Draw Tools are selected (which is appropriate, because note duration is meaningless for tools 
that don't draw notes). It should be given a color that contrasts well with Focused Track Text. For whatever reason, the HUD 
uses Cell 1 for the Smart Tool.

• Cell 5 has the usual Control Bar cell 5 duty of getting displayed when no project is loaded.

These observations seem mostly consistent with how the button works in the Control Bar Tools Module (see above).

To Be Determined: What theme color is used for the text in the resolution button? It isn't Track view / Focused Track Text. 

2. Control Bar Page  21



2.3. Snap module

Control Bar / Modules / Snap / Menu
This element is displayed only when the Musical Time Snap is "measures", "samples", "ticks", etc.

In all other cases, the individual note length menu images are displayed:

Control Bar / Modules / Snap / Triplets button
Control Bar / Modules / Snap / Dotted Note button
Control Bar / Modules / Snap / Whole Note
Control Bar / Modules / Snap / 1/2 Note
Control Bar / Modules / Snap / 1/4 Note
etc...

2.4. Transport module

Control Bar / Modules / Transport / Text

Control Bar / Modules / Transport / Background

Control Bar / Modules / Transport / Background (small)

Control Bar / Modules / Transport / Background (collapsed)

Two shades of pink are used to show the areas of the background images. If you like the lines, you should retain them in your image.
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Transport Buttons

The strip represents five states:

1. Enabled / Ready

2. Mouse down on Enabled

3. Hover when Enabled

4. Playback Active

5. Disabled / Not available / No Project Open

Control Bar / Modules / Transport / Rewind
Control Bar / Modules / Transport / Stop
Control Bar / Modules / Transport / Play
Control Bar / Modules / Transport / Arranger preview
Control Bar / Modules / Transport / Pause
Control Bar / Modules / Transport / Forward
Control Bar / Modules / Transport / Record
Control Bar / Modules / Transport / Record Overwrite
Control Bar / Modules / Transport / Record Sound on Sound
Control Bar / Modules / Transport / Step Record

Track view / Unfocused Track Text
Slider background, from the beginning of the project up to the Now time:

Also used in:

(other places - see complete list)

Control Bar / Modules / Transport / RTZ
Control Bar / Modules / Transport / Go to End
5 states:

1. Normall

2. Clicked/Pressed

3. Mouse-Over

4. Not used

5. Unavailable/No Project Open

Control Bar / Modules / Transport / Now Slider
This is just a single image, and does not change state when clicked or moved by the mouse.

Control Bar / Modules / Transport / Metronome During Playback
Control Bar / Modules / Transport / Metronome During Record
Control Bar / Modules / Transport / Metronome Settings
States:

1. Normal
2. mouse down / clicked
3. mouse over / hover
4. (unknown)
5. no project open / unavailable
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Control Bar / Modules / Transport / Viewport Background
Only appears during project load, mixdown, and similar temporary processes:

See Case Study: Viewport Background for more on this.

Control Bar / Modules / Transport / Progress Bar Cancel
See [x] in the image above

2.5. Custom module

Control Bar / Modules / Custom / Custom Button
This is worth some detail: 

In Mercury, the button image is:

Let's see how that is reflected in the rendered UI:

From left to right we have:  Normal;  Mouse-over;  and Un-assigned:

From left to right we have: Normal;  Mouse Down/Clicked; and Normal: 

So I'm going to conclude that the function of each sub-image is, from left to 
right:

• Normal

• Clicked/Mouse-down

• Mouse-over / Hover

• not used? not identified

• Blank / No function assigned

Let's compare:

In Tungsten, the button image is:

Interesting, we have some transparency/alpha-channel in play. Let's see how that is reflected in the rendered UI:

From left to right we have:  Normal;  Mouse-over;  and Un-assigned: 

From left to right we have:  Normal; Mouse-down/Clicked; and Normal:

See also: B: Case Study: 1. Control Bars

2.6. Mix module
These functions can be divided into two categories:

• Operations that make changes to your projects

• Operations that enable/disable a feature

For example, the Mute, Solo, Record, Input Echo, and Write Automation buttons will all change how tracks in your projects are 
configured. 

On the other hand, Read Automation, FX Bypass, etc, only toggle the current state. They are reversable operations.

That's something to think about when deciding on how to theme these buttons.
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3. Track View

Global / Toolbar Background
The Track view window background color is set by this element, which also impacts numerous other places in the Cakewalk application.

Also used in:

9. Piano Roll view  window background

15. Loop Construction view toolbar background

17. Lyrics view window background

21. Tempo view window background

30. Plug-in Property window background

Global / Toolbar Static Text
Vertical scale rule text for each track:

Track view / Auto Crossfade Button

Track view / Ripple Edit Button
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Global / Menus / View Menu Text 
Ripple Edit Menu button text color:

Also used in:

(other places - see complete list)

Track view / Active Outline

It's a thin box  that outlines either the Track or Bus pane, depending on whether a Track or Bus is selected:

It's a pretty subtle visual aid.

Track view / Strip Under
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3.1. Track View Header

Track view / Unfocused Track Text
The Track view Now Time display text:

Also used in:

(other places - see complete list)

Track view / Add Track flyout / Add Track Button
Each image in the strip represents:

1. Normal

2. Mouse down (pressed)

3. Mouse over (highlight)

4. (not used)

5. Unavailable (e.g. no track to duplicate)

Note that in the default themes, (4) is colored as though it was the "active" state, but is not shown in normal use.

Track view / Track Pane / Duplicate Track Button
Each image in the strip represents:

1. Normal

2. Mouse down (pressed)

3. Mouse over (highlight)

4. (not used)

5. Unavailable (e.g. no track to duplicate)

Note that, in the default themes, (4) is colored as the "active" state, but is not shown in the UI in normal use.

Track view / Track Pane / Edit Filter

Global / Menus / View Menu Text
Edit Filter menu text:

Also used in:

(other places - see complete list)

3. Track View Page  27



3.2. Add Track Flyout

Track View / Add Track flyout / Check Box
From left to right, the images are used as:

1. unchecked / unselected

2. mouse press, when unchecked

3. mouse over, when unchecked

4. checked / selected

5. mouse press, when checked

6. mouse over, when checked

7. disabled, checked?

8. ? (transparent)

Track view / Add Track flyout / Background
Track view / Background Bottom Panel
Track view / Advanced (Arrows)
Track view / Audio Tab
Track view / Instrument Tab
Track view / Create button
Track view / Number of Tracks Background
Track view / Less Tracks
Track view / More Tracks
Track view / Drop-down Menu
Track view / Drop-down Menu (narrow)
Track view / Drop-down Menu (narrow 2)

Track View / Unfocused Track Text
In the Add Track Flyout dialog, the digit that indicates how many tracks you're adding:

       credit: @StarshipKrupa

Also used in:
 (see complete list)

ProChannel / Modules / QuadCurve EQ fly-out / Close Zoom Window
This "x" icon is used for the close box on the Add Track flyout dialog (see image above). 
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3.3. Track View Ruler

Time Ruler / Time Ruler Background 

Also used in:

15. Loop Construction view window background

16. Event List view column header background

20. Markers view window background

22. Meter/Key view window background

23. Sysx view window background

In addition to the dependency that other parts of the UI have on this theme element, there are other considerations:

A selected region will invert the color of the ruler. For example, with the ruler background set to White, the selected zone will be Black, 
which may render the Selection Marker invisible if it also happens to be Black or near-Black:

Also, the numbers and tick marks under the selected area may become difficult to read. It's a balancing act.

Another thing to consider is that the Aim Assist info text really doesn't like super-light backgrounds:

Time Ruler / Track View Time Ruler Digits 

Also used in:

12. Staff view ruler bar/beat indicator text and grid

15. Loop Construction view ruler tick marks

16. Event List view column header outline

Time Ruler / Time Ruler Tick Marks 

Time Ruler / Markers / Markers 

Time Ruler / Markers / Pitch Markers 
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Time Ruler / Markers / Selection Markers 

Time Ruler / Markers / Loop Markers 

Both Selection and Loop markers may be rendered in a less-saturated version of the color you choose for the theme. 

Time Ruler / Markers / Punch Record Markers 

Time Ruler / Markers / Now Time Marker 

Time Ruler / Add Ruler
Time Ruler / Remove Ruler
The Cakewalk UI does not respect transparency. Any transparent regions will be filled with black, regardless of the underlying 
window/toolbar color. Therefore, we need to either fill the 16x16 image completely, or fill the background ourselves with the 
appropriate color.
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3.4. Track View Track Strips
This is where each Track Strip contains controls for the configuration of  the track:

Track view / Focused Strip Background 

Track view / Unfocused Strip Background
 This color element is used for Folders as well as un-selected tracks:

Track view / Focused Track Background

Also used in:

9.1 Piano Roll view Track Pane focused track background

9.1. Piano Roll View focused controller lane name

13. Synth Rack view focused synth name background

Track view / Unfocused Track Background 
Normal, un-selected tracks - and folders - use this color for the Name background. 

Track view / Focused Track Text

Also used in:

2.2. Control Bar Tools module Draw Note Button text

5.10. Console view selected track name text
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13. Synth Rack view focused synth name text

Track view / Bus Name Text  
Track view / MIDI Track Name Text 
Track view / Audio Track Name Text

Also used in:

13. Synth Rack view un-focused synth name text

Track view / Instrument Track Name Text
Track view / Folder Name Text 

I am using Red (Bus), Yellow (MIDI), Blue 
(Instrument), Green (Audio), Pink (Folder) to 
illustrate each track type. 

Note that the Focused track uses the Focused Track 
Text color for all track types. 

Only Un-Focused tracks use these color settings.

Icons / Track header icons
See separate Icons section.

Track view / Header Track Number 
Un-selected Track, Number text:

Track view / Track View Header Selected Track Number
Selected Track, Number text:

Track view / Track Pane / Selected Track 
Selected Track, Number background:
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Track view / Pane Background
Used in both Track Pane and Bus Pane:

Track view / Control Outline 
“Control Outline” is apparently just used for the Track Name:

Track view / Current Control Outline 
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Track view / Track Pane / Menu Button 
Track filter, input and output menu buttons:

@sjoens notes there is an anomaly here, in that "all three use the same button, but the Input/Output buttons are displayed squished by 
2 pixels in height".

Track view / Track Pane / Description Field 
Background of the Send module (not intuitive!):

Also used in:

3.10 Track view Track Folder control background and folder description background

Track view / Track Pane / Minimize/Expand Strip 
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Track view / Track Pane / Read Automation
Eight possible states:

1. Enabled, Inactive (Off)

2. Mouse down (pressed) when Inactive

3. Mouse over (highlight) when initially Inactive

4. Enabled, active (On) - this is the defalt state for "Read Automation")

5. Mouse down (pressed) when Active

6. Mouse over (highligh) when initially Active

7. unknown state (unavailable/disabled?)

8. Indicates that there are multiple take lanes with different Read Automation states (tri-state)

Track view / Track Pane / Global Read Automation Disable
Compare with previous item. 

Also:

Left: Global Override=Enable (default);  Right: Global Override=Bypass

Refer to Read Automation States in the Case Study section at the end of this document.

Track view / Track Pane / Freeze
Track view / Track Pane / Archive
Up until 2021.12, this was a 5-impression button set. With the introduction of Nested Folders, this became expanded to 8 possible 
states:

Eight possible states:

1. Normal default when Un-archived

2. Mouse down/pressed when Un-archived

3. Hover when Un-archived

4. Normal/default when Archived

5. Mouse down/pressed when Archived

6. Hover when Archived

7. (unknown)

8. Partial (some tracks contained in folder are archived, some are not).
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Track view / Track Pane / Mute
Eight possible states:

1. Normal Un-muted

2. Click when Un-muted

3. Hover when Un-muted

4. Normal Muted

5. Click when Muted

6. Hover when Muted

7. Archived Track

8. (unknown)

Track view / Track Pane / Mute Tri-state
Similar to Mute, but used for folders:

       8. Some tracks in the folder are Muted, some are not.

Track view / Track Pane / Solo
Track view / Track Pane / Solo Tri-state
Track view / Track Pane / Arm for Recording
The mysterious 8th impression is shown in MIDI tracks when Input Quantize is on (thanks @sjoens)
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Track view / Track Pane / Send Enable
Track view / Track Pane / Send Pre/Post

Track view / Track Pane / Input Control Icon
Track view / Track Pane / Output Control Icon
Track view / Track Pane / Channel Control Icon
Track view / Track Pane / Bank Control Icon
Track view / Track Pane / Patch Control Icon

Note: These widget icons are also used in the Add Track Flyout dialog 
for input and output selection.

Note: These are different from the icons used in Console View MIDI Track strips.

Track view / Track Pane / Show/Hide Take Lanes
Track view / Track Pane / Show/Hide Automation Lanes
Six possible states:

1. No take lanes exist

2. Pressed (when no take lanes exist)

3. Mouse over (when no take lanes exist)

4. Take lanes open and visible

5. Track with no take lanes is ARCHIVED

6. Take lanes exist but not currently expanded

Global / Alternative Text #2
Drop-down menu text:

Also used in:

Control Bar modules: button and drop-down menu text
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Global / Horizontal Sliders 
Horizontal slider foreground color:

Also used in:

3.9. Track view Video Thumbnails, video name and control value text

6. Inspector property value text and sliders

11. Matrix View drop-down menu text

Track view / Unfocused Track Text
An unexpected dependency on this element is setting the track control Value text:

Also used in:

(other places - see complete list)

Global / Quick Group 
More on Quick Groups. Here is where the color shows up:

Track view / Header Peak Text
This element is used to color the maximum peak level, displayed just to the right and above the FX bin:
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Track view / Bus Pane / Waveform Preview
Track view / Bus Pane / Bus Waveform Preview 
Instrument and Aux Tracks have the capability of displaying a virtual waveform during playback. By enabling the Waveform Preview 
button in the header (shown here in Orange, active) you can view a rendered waveform during playback in the Clip Pane:

This feature was first introduced for Busses, which is why the theme elements are located under “Bus Pane”. 

Track view / Folders / Open/Close Folder
TBD
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3.5. Track View Meters

Meters / Segmented Meters / VU Tick Marks 
The tick marks are only visible when Options > Meter Options > Record/Playback/Bus Meter Options > Show Labels is selected.

Meters / Non-segmented meters / VU Lo level
The element color is used to form a gradient, with a max level represented by the color chosen for this element:

Also used by:

5.8. Console View Meters

Meters / Non-segmented meters / VU Hi level
Using the same color for Hi Level, the result:

Also used by:

5.8. Console View Meters

Meters / Track View meters / Vertical Audio Meters
Meters / Track View meters / Vertical Audio Meters (narrow)
Meters / Track View meters / Vertical Audio Meters (very narrow)
These “segmented meter” items are mostly straight-forward. The images are intelligently resized along with the track strips.

Meters / Track View meters / Vertical Audio Meter Scale background
This only shows up in the UI when:

• Track View > Options > Meter Options > Record/Playback/Bus meters are visible

• Preferences > Customization > Audio Meter > Segmented Meters is selected;

• Track View > Options > Meter Options > 
Record/Playback/Bus Meter Options > Show Labels is selected.
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Meters / Track View meters / Horizontal Audio Meters
Meters / Track View meters / Horizontal Audio Meters (narrow)
Meters / Track View meters / Horizontal Audio Meters (very narrow)

Meters / Track View meters / Horizontal Audio Meter Scale background
This only shows up in the UI when:

• Track View > Options > Meter Options > Record/Playback/Bus meters are visible

• Preferences > Customization > Audio Meter > Segmented Meters is selected;

• Track View > Options > Meter Options > Record/Playback/Bus Meter Options > Show Labels is selected.

Meters / Track View meters / Vertical MIDI Meters
Meters / Track View meters / Horizontal MIDI Meters
Similar to Vertical/Horizontal Audio meters, see above.

3.6. Track View FX Rack

FX Rack / FX Name

Also used in:

5.3 Console FX bin FX name

FX Rack / Bypassed FX Name

Also used in:

5.3. Console view FX Bin Bypassed FX name
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FX Rack / Bypass FX Rack
There are seven states represented in the image (from left to right):

1. On
2. Press Off
3. Hover when On
4. Off
5. Press On
6. Hover when off
7. n/a

Console view / Modules / Sends/Patch / Open Insert Send Menu
Track View Add Plugin button:

Also used in:

5.5. Console View FX and Send Bins

Console view / Modules / Sends/Patch / Scroll Sends Down
Console view / Modules / Sends/Patch / Scroll Sends Up
Track View FX Bin when size forces contents into scrollable list:

FX Rack / Name Background
FX Rack / Name Background (ACT Focus)
The two slides in the theme element are used to show Enabled (light) and Disabled (dark) plug-ins:

FX Rack / Bypass Plug-in
FX Rack / Bypass Plug-in (ACT Focus)
Mouse-over an enabled plug-in to view:

FX Rack / Bypass Plug-in Enabled
FX Rack / Bypass Plug-in Enabled (ACT Focus)
Mouse-over a disabled plug-in to view:
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FX Rack / Open Plug-in UI
FX Rack / Open Plug-in UI (narrow)
FX Rack / Open Plug-in UI (ACT Focus)
FX Rack / Open Plug-in UI (narrow ACT Focus)
This element is used to decorate the FX Bin plug-in. It has three panels, [1-3].

How are they used?

Normal Hover over bypass button Hover over middle Click on middle click on dropdown

You'll want to think about how to achieve the best results visually for your customization.

FX Rack / Open Plug-in UI Bypassed
FX Rack / Open Plug-in UI Bypassed (narrow)
FX Rack / Open Plug-in UI Bypassed (ACT Focus)
FX Rack / Open Plug-in UI Bypassed (narrow ACT Focus)
Mouse over and click on a disabled plug-in to view:

FX Rack / Show Rack Menu Drop-down
FX Rack / Show Rack Menu Drop-down Bypassed
FX Rack / Show Rack Menu Drop-down (ACT Focus)
FX Rack / Show Rack Menu Drop-down Bypassed (ACT Focus)
Mouse-over the enabled or disabled plugin to view:

FX Rack / Track Inspector FX Rack Not yet identified
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3.7. Track View Bus Pane

Track view / Bus Pane / Bus Waveform Preview 
This is the color of the rendered waveform in the clip pane (see image below in pink).

#ToDo: What dictates the color of clipping in the waveform preview?

Track view / Bus Pane / Waveform Preview
This is the button (orange) in the track strip that enables the waveform preview:

Track view / Bus Pane / Bus Pane Hide
Track view / Bus Pane / Bus Pane Show
This image does NOT respect transparency. You will have to fill out the background to suit your theme.

(Color Pref) Peak Marker Text
(Color Pref) Peak Marker (<=0dB)
(Color Pref) Peak Marker (>=0dB)
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3.8. Track View Clips Pane

Track view / Clips Pane / Track View Clips Pane Background

(Also used in the Video Thumbnail track, on the Clip Pane side.)

Track view / Clips Pane / Aim Assist Line
Track view / Clips Pane / Clips Pane Ellipse
Track view / Clips Pane / View Background (odd)
Track view / Clips Pane / View Background (even)

The following UI features do not appear to have corresponding Theme Editor elements, and must instead be customized in the Edit > 
Preferences > Customization > Colors  options:

(Color Pref) Record Preview Clip Background
(Color Pref) Vertical Beat Lines
(Color Pref) Vertical Measure Lines
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3.9. Track View Clips

Track view / Clips Pane / Clips / Clip Name 

Track view / Clips Pane / Clips / Clip Name (selected) 

Track view / Clips Pane / Clips / Clip Events Not used?

#ToDo: This needs to be documented. By default it's a bright red color. Where is it used? 

Track view / Clips Pane / Clips / Clip Header

Track view / Clips Pane / Clips / Clip Header (selected)

Track view / Clips Pane / Clips / Clip Background (selected)
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Track view / Clips Pane / Clips / Clip Zero Amplitude Line

Track view / Clips Pane / Clips / Audio Tracks 1,11,21... Foreground
Track view / Clips Pane / Clips / Audio Tracks 2,12,22... Foreground
Track view / Clips Pane / Clips / Audio Tracks 3,13,23... Foreground
Track view / Clips Pane / Clips / Audio Tracks 4,14,24... Foreground
Track view / Clips Pane / Clips / Audio Tracks 5,15,25... Foreground
Track view / Clips Pane / Clips / Audio Tracks 6,16,26... Foreground
Track view / Clips Pane / Clips / Audio Tracks 7,17,27... Foreground
Track view / Clips Pane / Clips / Audio Tracks 8,18,28... Foreground
Track view / Clips Pane / Clips / Audio Tracks 9,19,29... Foreground
Track view / Clips Pane / Clips / Audio Tracks 10,20,30... Foreground
These are the default colors used to paint Audio clip waveforms.

Track view / Clips Pane / Clips / Tracks 1,11,21... Background
Track view / Clips Pane / Clips / Tracks 2,12,22... Background
Track view / Clips Pane / Clips / Tracks 3,13,23... Background
Track view / Clips Pane / Clips / Tracks 4,14,24... Background
Track view / Clips Pane / Clips / Tracks 5,15,25... Background
Track view / Clips Pane / Clips / Tracks 6,16,26... Background
Track view / Clips Pane / Clips / Tracks 7,17,27... Background
Track view / Clips Pane / Clips / Tracks 8,18,28... Background
Track view / Clips Pane / Clips / Tracks 9,19,29... Background
Track view / Clips Pane / Clips / Tracks 10,20,30... Background
These are the default colors used to paint Audio and MIDI clip backgrounds.

Track view / Clips Pane / Clips / MIDI Tracks 1,11,21... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 2,12,22... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 3,13,23... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 4,14,24... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 5,15,25... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 6,16,26... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 7,17,27... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 8,18,28... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 9,19,29... Foreground
Track view / Clips Pane / Clips / MIDI Tracks 10,20,30... Foreground
These are the default colors used to paint MIDI note events  in MIDI clips.
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Track view / Clips Pane / Clips / MIDI Tracks 1,11,21... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 2,12,22... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 3,13,23... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 4,14,24... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 5,15,25... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 6,16,26... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 7,17,27... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 8,18,28... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 9,19,29... Background No longer used
Track view / Clips Pane / Clips / MIDI Tracks 10,20,30... Background No longer used
"MIDI Track Background" colors are no longer used. Instead, the "Tracks [n] Background" colors above apply to both Audio and MIDI 
tracks.

Track view / Clips Pane / Clips / Clip Icon FX
Track view / Clips Pane / Clips / Clip Icon V-Vocal
Track view / Clips Pane / Clips / Clip Icon AudioSnap
Track view / Clips Pane / Clips / Clip Icon AudioStretch
Track view / Clips Pane / Clips / Clip Icon Piano Roll
Track view / Clips Pane / Clips / Clip Icon Staff View
Track view / Clips Pane / Clips / Clip Icon Event List
Track view / Clips Pane / Clips / Clip Icon Step Sequencer
Track view / Clips Pane / Clips / Clip Icon Lock All
Track view / Clips Pane / Clips / Clip Icon Lock Position
Track view / Clips Pane / Clips / Clip Icon Lock Data

(Color Pref) Clip Gain Envelope
(Color Pref) Clip Pan Envelope
These colors are used to hint/tint the envelopes in various states of visibility:

(Color Pref) Clip Velocity Envelope
(Color Pref) Clip Fades
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3.10. Track View Video Thumbnails

Meters / Track View meters / Background VR
Unexpectedly, this theme element affects the background of the Video Thumbnail lane in the Track Pane:

Track view / Video Thumbnails / Show/Hide Video Thumbnails
Track view / Video Thumbnails / Show/Hide Video Frame Numbers

Track view / Video Thumbnails / Video Display Port

#ToDo: Video Thumbnail Track Name Background = ?

Global / Horizontal Sliders

Also used in:

(other places - see complete list)

Track view  / Disabled Control Text

Some research from @sjoens has shown that these control values are not painted consistently. On initial application load, the values are 
painted using Track View / Disabled Control Text as described here.

However, when re-applying a theme from Preferences, the values are painted using Track View /Control Text & Values. I think this is 
a bug in the refresh code for selecting themes from Preferences. My advice would be to ensure the first theme item is colored as 
desired so that the initial display of theme upon opening Cakewalk is correct. If this glitch bothers you, make both color elements the 
same. (And avoid BLACK so that the values are visible/readable!)

Track view  / Clips Pane / Track View Clips Pane Background
This is used to color the background of the Video Thumbnail strip, on the Clip Pane side of the Track View.
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3.11 Track View Folders

Track view / Track Pane / Description Field
The expanded Folder strip:

Also used in:

3.4. Track view Track Strip Send module background

The use of this element appears to be erratic.

At two different times, on the same computer, the theme "Flight Deck" shows both the "expected" use of the Description Field, and also 
ignores it and uses some gradient fill instead.

Even the default themes exhibit this behavior. This is a mystery! More information as it comes to hand.

Track view / Unfocused Track Text

Also used in:

(other places - see complete list)

Track view / Disabled Control Text
I didn't realize that these are actually buttons you can click on to filter the displayed contents of the folder:

Also used in:

3.9 Track view Video Thumbnail control value text
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Track view / Control Text and Values
Folder description text:

Also used in:

3.11. Track view Take Lane description text

(Color Pref) Folder Clip Background

(Color Pref) Folder Clip Text
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3.12. Track View Take Lanes

Track view / Track Pane / Add Lane TBD
Track view / Track Pane / Remove Take Lane TBD
Track view / Control Text and Values
Take Lane description text:

Note that the background of the text area is not affected by themes, so you should ensure that this theme element is bright enough to 
be readable on the dark grey background.

(Color Pref) Comp Header
This is the background color of the header that appears in clips in the Parent Track of the expanded take lanes:

3.13. Track View Automation Lanes

Track view / Track Pane / Add Lane TBD
Track view / Track Pane / Remove Automation Lane TBD

3. Track View Page  52



3.14. Unidentified

Track view / Strip Background Not yet identified
Track view / Control Background Not yet identified
Track view / Track Icons Background Not yet identified
Track view / Control Icon Not yet identified
Track view / Slider Background Not yet identified
Track view / Track Name Outline Not yet identified
Track view / Track Inspector Background Not yet identified
Track view / Header Time Display Not yet identified
Track view / Track Pane / Active Track Not yet identified
Track view / Track Pane / Strip Selection Not yet identified

Track view / Track Pane / Open Synth Properties Not yet identified
Background:

Synth and Instrument tracks allow you to open the VSTi property window by clicking on the icon in the Track Header.

This ability is visually indicated by a blue outline around the icon, suggesting that you can click on it with the mouse.

It's possible this theme element used to be an overlay on the Track Header Icon for VST instruments, but is no longer used.

Even when we edit the element to be bright pink, the button highlight on mouse-over remains blue:
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4. Browser

Global / View Border
Browser window backround:

Also used in:

(other places - see complete list)

Global / Menus / View Menu Text
Drop-down menu text:

Also used in:

(other places - see complete list)

Browser / Media Browser / Content Location Menu
Drop-down menu:

Also used in:

13. Synth Rack view automation menu

Browser / Media Tab
Browser / Media Tab (narrow)

Browser / Media Tab (no corner)
Browser / Media Tab (narrow no corner)
These elements only appears when the Browser is docked on the LEFT side:
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Browser / PlugIns Tab
Browser / PlugIns Tab (narrow)
Browser / PlugIns Tab (collapsed)
Browser / Notes Tab
Browser / Notes Tab (narrow)
Browser / Notes Tab (collapsed)
Browser / Synth Rack Tab Not Used / Obsolete
Browser / Synth Rack Tab (narrow) Not Used / Obsolete
Browser / Synth Rack Tab (collapsed) Not Used / Obsolete
Browser / Search Icon
Appears in the search text box at the top of the Media and Plugins tab (see images above).

4.1. Media Browser

Track view / Unfocused Track Text
Filename text color:

Also used in:

(other places - see complete list)

Browser / Media Browser / Clear Search
Browser / Media Browser / Delete Content Location Preset
Browser / Media Browser / Save Content Location Preset
Browser / Media Browser / Move Up One Level
Browser / Media Browser / Start/Stop Previw
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4.2. Plug-in Browser
Note: A re-start is required for the Cakewalk UI to respect changes to these items; switching Themes alone is not guaranteed to 
reflect it.

Browser / Plug-in Browser / Plug-in Tree Text 
This affects names of folders, and plug-ins that are not VST2 or 32-bit (e.g. VST3 and DirectX). I hesitate to call this the "default color" 
for text in the plug-in browser, but you could think of it that way.

And an anomaly identified by @sjoens: Prior to re-opening the plug-in browser, the folder names are actually set by the Track View / 
Unfocused Track Text. We'll leave it at that.

Browser / Plug-in Browser / VST2 Text
This affects names of VST2 plug-ins (that are not 32-bit).

Browser / Plug-in Browser / 32-bit Plug-ins Text
This affects names of 32-bit plug-ins.
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Browser / Plug-in Browser / Plug-in Tree Icons
Each plug-in shown in the Browser tree view includes an icon indicating its type. These images can be found and customized in this 
element, a strip of 19 transparent background images, each 16x16 pixels:

From left to right, they represent:

1. ? (audio FX?)
2. ?
3. MIDI FX
4. ? (control surface?)
5. ?
6. Tree node folder, collapsed
7. Tree node folder, expanded
8. ? white bar of unknown use
9. FX Chain
10. VST  effect
11. VST  instrument
12. VST  effect (32-bit)
13. VST  instrument (32-bit)
14. VST3 effect
15. VST3 instrument
16. VST3 effect (32-bit)
17. VST3 instrument (32-bit)
18. DirectX effect (and External Insert)
19. DirectX instrument

Prior to the 2021.04 release, these icons were also used for icons 
in the "Add Track" instrument selection drop-down menu (see right):

Fun Fact from @sjoens:

The first two entries in this icon strip were used in previous versions of SONAR as shown in this pic from Sonar X1 Browser:

Tip: @sjoens changed their tree and text colors to be less confusing. Currently, 3 text colors for 4-5 FX states that don't match the icons 
is confusing. They now match the plugin menu list colors (see below):
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The menus in 2021.04 have been re-implemented, and now do not show an icon, but instead show text indicating the type (VST2, VST3, 
DX, etc). The color of these text indicators do not appear to be customizable.

These color items are also used in the new "Add Instrument Track" and "Add FX plug-in" drop-down menus in release 2021.04 EA1:

As you can see, in these menus, the "DX" tag does not seem to use the same coloring as the Plug-in Browser. In fact, in 2021.04, it does 
not appear to be affected by any theme element.

A side-effect of the menus introduced in 2021.04 is that you have a new constraint on selecting colors to use in the Plug-in Brower, to 
make sure they are visible both on a black background, and the light grey menu background.

Browser / Plug-in Browser / Audio FX Button
Browser / Plug-in Browser / Instruments Button
Browser / Plug-in Browser / MIDI FX Button
Browser / Plug-in Browser / ReWire Button
Browser / Plug-in Browser / Audio FX Button (narrow)
Browser / Plug-in Browser / Instruments Button (narrow)
Browser / Plug-in Browser / MIDI FX Button (narrow)
Browser / Plug-in Browser / ReWire Button (narrow)
These next set of element are misleading - they look like they are used for plug-in type indicators, but in fact they are not used at all:

Browser / Plug-in Browser / PlugIn Types / DirectX FX Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST2 FX 32-bit Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST2 FX 64-bit Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST3 FX 32-bit Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST3 FX 64-bit Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / DirectX Synth Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST2 Synth 32-bit Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST2 Synth 64-bit Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST3 Synth 32-bit Not used / Obsolete
Browser / Plug-in Browser / PlugIn Types / VST3 Synth 64-bit Not used / Obsolete

Global / Menus / View Menu Text
This determines the color of the description text at the bottom of the Plug-in Browser list:
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4.3. Notes Browser

Browser / Notes Browser / Control Background
Browser / Notes Browser / Control Border
Browser / Notes Browser / Button Text Color
Browser / Notes Browser / Button Text Color (Highlighted)

Track view / Unfocused Track Text
Another unexpected dependency on Unfocused Track Text: the text color in the Notes Browser:

Also used in:

(other places - see complete list)

Browser / Notes Browser / File Stats Button
Browser / Notes Browser / OK and Cancel Buttons
Browser / Notes Browser / Add Project Icon
Browser / Notes Browser / Clear Project Icon

4.4 Collapsed Tabs

Browser / Media Tab (collapsed)
Browser / PlugIns Tab (collapsed)
Browser / Notes Tab (collapsed)
Browser / Help Module (collapsed)
The buttons that show up in the collapsed Browser have three impressions:

Normal, Active, and Disabled/Unavailable. The middle frame appears not to be used.

When you click on a tab button in the collapsed frame, the Browser expands immediately, with the appropriate tab open and selected. 
So there is probably no need to customize the second impression in the theme elements.

The impressions seem to be 2 pixels too wide. By default, they overlap the black outer border of the application window.

If you like this look, then no change is necessary. Otherwise, removing a 2 pixel strip (set alpha channel to 0) from the right edge seems 
to do the trick:
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Browser / Synth Rack Tab (collapsed) Not used / Obsolete
Interestingly, this theme element for the Synth Rack does not appear to be used in practice. The Synth Rack is kind of a separate 
window from the Browser, but even when the Browser is undocked and the Synth Rack is docked and collapsed, the only tab buttons 
that show up on the collapsed frame are those of the Browser:
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5. Console View

Console view / Unfocused Strip Background

Console view / Focused Strip Background 
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Console view / Background #1

Also used in:

6.1. Arranger Inspector background

Console view / Splitter Gradient (Top) 

Console view / Splitter Gradient (Bottom)
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Console view / Footer Gradient Start 

Console view / Footer Gradient End 
Looks like the footer only appears when not hidden behind a horizontal scrollbar:

Console view / Background #2 

Console view / Vertical Scroll Strip Background Gradient (top)
Very subtle, on the far right:
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Console view / Vertical Scroll Strip Background Gradient (bottom)
Subtle on the far right:

Console view / Horizontal Scroll Strip Background (top)
Only visible when not overlayed by horizontal scroll bar:

Console view / Control Text and Values 
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Console view / Menu
Console view / Menu (pressed)
It is interesting that  the "pressed" (Dark Pink) and "non-pressed" (Pink) states are used for different buttons, not different states:

Primarily, Menu (pressed)  is used. Only MIDI tracks use Menu for a couple of controls. When customizing these images, bear in mind 
that neither of them actually shows a different state when "pressed". You might wish to make them visually identical, or use some 
graphic technique to make them look different, but indicating a "pressed state" doesn't seem useful.

What about the "narrow" menus?

Console view / Menu (narrow) Not yet identified
I haven't found an example of this element being used in the UI.

Console view / Menu (narrow pressed)
Interesting: Only the "pressed" state seems to be used for the narrow strips, whether the menu is "pressed" or not:

The comment against "Menu (pressed)" above applies here also.

Console view / Separator
This is the horizontal line between modules in the Console view:
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Console view / Strip Label Text
Shown here in green:

Console view / Strip Background Not yet identified
Console view / Slider Background Not yet identified

5.1. Console Input Gain/Pan

Console view / Knob Unipolar
Console view / Knob Unipolar (small)
Console view / Knob
Console view / Knob (small)

Input Gain and Input Pan:

Console view / Modules / Input Gain / Background Not used/Obsolete
Console view / Modules / Input Gain / Background (selected) Not used/Obsolete
Console view / Modules / Input Gain / Background (narrow) Not used/Obsolete
Console view / Modules / Input Gain / Background (narrow selected) Not used/Obsolete
Console view / Modules / Input Gain / Bus Background Not used/Obsolete
Console view / Modules / Input Gain / Bus Background (selected) Not used/Obsolete
Just based on the graphic and the selected/unselected versions, I suspect these are obsolete, from back before colored track strips were 
implemented.

Console view / Modules / Input Gain / Background.png
Console view / Modules / Input Gain / Background (narrow)
Console view / Modules / Input Gain / Bus Background
These transparent versions are the ones actually used now.

5.2. Console ProChannel

Console view / Modules / ProChannel / EQ Plot Grid Not used/Obsolete
Console view / Modules / ProChannel / EQ Plot Graph Not used/Obsolete
I have no idea what these two color values were used for although I guess their name gives a hint. Anyway, I've not yet managed to 
observe them in the Cakewalk UI.

Console view / Modules / ProChannel / Background (selected) Not used/Obsolete
Console view / Modules / ProChannel / Background (narrow) Not used/Obsolete
Console view / Modules / ProChannel / Background (narrow selected) Not used/Obsolete
I suspect these are obsolete, from back before colored track strips were implemented.
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Console view / Modules / ProChannel / Background
Console view / Modules / ProChannel / Background (narrow)
These transparent ones are actually used:

Track view / Unfocused Track Text
The preset Name text:

Also used in:

(other places - see complete list)

Console view / Modules / ProChannel / Global Enable
Console view / Modules / ProChannel / Global Enable (narrow)
Console view / Modules / ProChannel / EQ Plot (narrow)
This is used for narrow console strips:

Note: The wider (default) strip EQ plot background is themed using ProChannel / EQ Plot.

Console view / Modules / ProChannel / EQ Knob Black
Console view / Modules / ProChannel / EQ Knob Black Bipolar
Console view / Modules / ProChannel / EQ High Band Knob
Console view / Modules / ProChannel / EQ High Band Knob Bipolar
Console view / Modules / ProChannel / EQ Low Band Knob
Console view / Modules / ProChannel / EQ Low Band Knob Bipolar
Console view / Modules / ProChannel / Gray Knob
Console view / Modules / ProChannel / Compressor Button (narrow)
Console view / Modules / ProChannel / EQ Button (narrow)

ProChannel / Pre/Post Toggle
Also used by:

7. ProChannel Pre/Post toggle button

Console / Modules / ProChannel / Post Button (narrow)
It is interesting that the normal and narrow versions are stored in such different locations.

States:

1. Inactive/Off    2. Clicked    3. MouseHover    4. Active/On      5. Disabled

Console view / Modules / ProChannel / Saturation Button (narrow)
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5.3. Console EQ

Console view / Modules / EQ / Background
Console view / Modules / EQ / Background (narrow)
Console view / Modules / EQ / Background Not used/Obsolete
Console view / Modules / EQ / Background (narrow) Not used/Obsolete
Console view / Modules / EQ / Background (selected) Not used/Obsolete
Console view / Modules / EQ / Background (narrow selected) Not used/Obsolete
Console view / Modules / EQ / EQ Plot Background Not used/Obsolete
Console view / Modules / EQ / EQ Plot Background (narrow) Not used/Obsolete

5.4. Console FX Bin
The Console view FX bin shares some theme elements with Track view:

FX Rack / FX Name

Also used in:

3.6. Track view FX Bin FX name

FX Rack / Bypassed FX Name

Also used in:

3.6. Track view FX Bin Bypassed FX name

If you chose to show Assignable Controls (Console View > Options > FX > Show Assignable Controls) then you see a list of controls 
under the FX bin:

Console view / Control Text and Values pink
Console view / Slider green
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Console view / Modules / FX Rack / FX Rack Background
Console view / Modules / FX Rack / FX Rack Background (narrow)
Console view / Modules / FX Rack / FX Rack Background (narrow selected)
Console view / Modules / FX Rack / FX Rack Background (narrow selected)
Console view / Modules / FX Rack / FX Rack Background
Console view / Modules / FX Rack / FX Rack Background (narrow)

5.5. Console Send Bin

Console view / Modules / Sends/Patch / Open Insert Send Menu
Used for both Add Plugin to FX Bin and Add Send.

Also used in:

3.6. Track View FX Bin

Console view / Modules / Sends/Patch / Sends Drop-down Menu
Console view / Modules / Sends/Patch / Sends Drop-down Menu (narrow)

Console view / Knob Unipolar
Console view / Knob (small)
Send Level and Pan:

Console view / Modules / Sends/Patch / Background [1] Not used / not yet identified
Console view / Modules / Sends/Patch / Background [1] (narrow) Not used / not yet identified
Console view / Modules / Sends/Patch / Background (selected) Not used / not yet identified
Console view / Modules / Sends/Patch / Background (narrow selected) Not used / not yet identified
Just based on the default graphics, it would appear to be earler or alternative versions that don't support colored strips. They've been 
superseded by the transparent versions.

Console / Modules / Sends/Bank/Patch / Background
Console / Modules / Sends/Bank/Patch / Background (narrow)
Send module background:

The image includes the Send Destination Background color 
(black with a 3D gloss tint, by default).

Note how tracks with no active Sends are rendered. 
There's another image involved:

Console / Modules / Sends/Bank/Patch / Send Module Background Tile
Console view / Modules / Sends/Patch / Send Module Background Tile (narrow)
This is the image that overlays the lower portion of the Send module on tracks with no Sends, giving it the appearance of an inactive or 
"greyed out" send.:
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Note that the default image uses transparency (alpha = ~50) to overlay the underlying color of the console track strip, whatever it may 
be (in case the user has selected to use colored track strips).

You could decide to replace this image with a blank, transparent rectangle, in which case the underlying track would show a completely 
empty Send module rather than the "fake" inactive send.

Console view / Modules / Sends/Patch / Surround Send Background
Console view / Modules / Sends/Patch / Surround Send Module Background Tile

Console / Modules / Sends/Bank/Patch / Enable Send
There are six states represented in the image (from left to right):

1. Hover over Send Name when Off
2. Press On
3. Hover when Off
4. Hover over Send Name when On
5. Press Off
6. Hover when On

Console view / Modules / Sends/Patch / Pre/Post Toggle
That's the blue circle in the image above.

5.6. Console MIDI settings
MIDI Tracks don't have Sends (yet!) but they do have Channel / Bank / Patch controls.

Console / Modules / Sends/Bank/Patch / Channel Control Icon
Console / Modules / Sends/Bank/Patch / Bank Control Icon
Console / Modules / Sends/Bank/Patch / Patch Control Icon

5.7. Console MSR

Console view / Modules / MSR / Stereo/Mono Interleave
Console view / Modules / MSR / Phase Invert
Console view / Modules / MSR / Read Automation See Case Study 
When Global Read Automation is enabled, the button set shown in the Console is actually:

Track view / Track Pane / Global Read Automation
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Console view / Modules / MSR / Write Automation
Console view / Modules / MSR / Write Automation Latch
Console view / Modules / MSR / Write Automation Overwrite
Console view / Modules / MSR / Write Automation Touch
Console view / Modules / MSR / Mute
Console view / Modules / MSR / Mute (Automated)
Console view / Modules / MSR / Solo
Console view / Modules / MSR / Arm for Recording
Console view / Modules / MSR / Input Echo
Console view / Modules / MSR / Hardware Out Link Channels
Used to indicate when the L and R channel faders are linked together.

1. Unlinked  2. Mouse click  3. Mouse-over/hover  4. Active/Enabled  5. Disabled/Unavailable 

Why use the same image for both states? Recommend instead:

Console view / Modules / MSR / Hardware Out Background Not used / not yet identified
Console view / Modules / MSR / Hardware Out Background (narrow) Not used / not yet identified

I suspect these are obsolete.

5.8. Console Pan

Console view / Knob

Console view / Modules / Pan / Background Not used / not yet identified
Console view / Modules / Pan / Background (narrow) Not used / not yet identified
Console view / Modules / Pan / Background (selected) Not used / not yet identified
Console view / Modules / Pan / Background (narrow selected) Not used / not yet identified
Again, I suspect these are obsolete left over from before coloured track strip backgrounds were implemented.

Console view / Modules / Pan / Background
Console view / Modules / Pan / Background (narrow)

5.9. Console Volume

Console view / Modules / Volume / Fader
Console view / Modules / Volume / Fader (narrow)
Console view / Modules / Volume / Bus Fader
Console view / Modules / Volume / Bus Fader (narrow)
Console view / Modules / Volume / Hardware Out Fader
Console view / Modules / Volume / Hardware Out Fader (narrow)
Console view / Modules / Volume / Fader Background
Console view / Modules / Volume / Audio Fader Scale
Console view / Modules / Volume / MIDI Fader Scale
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5.10. Console Meter
Console view meters share some theme elements with Track view:

Meters / Segmented Meters / VU Tick Marks 

Meters / Non-segmented meters / VU Tick Marks

Track view / Track View Header Warning Text 

Note: The Console view uses the "Track view Header Warning Text" element. This appears to be the only place this element is used! 
(Not even in the Track view itself.)

Meters / Non-segmented meters / VU Lo level
Meters / Non-segmented meters / VU Hi level

Also used by:

3.5. Track View Meters

Meters / Console View meters / Audio Meters
Meters / Console View meters / Meter background
Meters / Console View meters / Audio Meters (narrow)
Meters / Console View meters / Audio Meters (very narrow)
Meters / Console View meters / MIDI Meters
The uses of these elements are faily obvious.

5.11. Console Track I/O
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Console view / Modules / In/Out / Background Not used / Not yet identified
Console view / Modules / In/Out / Background (narrow) Not used / Not yet identified
Console view / Modules / In/Out / Background (selected) Not used / Not yet identified
Console view / Modules / In/Out / Background (narrow selected) Not used / Not yet identified
Just based on the default graphics, it would appear to be earler or alternative versions that don't support colored strips.

Console view / Modules / In/Out / Background
Console view / Modules / In/Out / Background (narrow)
Console view / Modules / In/Out / Input Control Icon
Console view / Modules / In/Out / Output Control Icon

5.12. Console Track Name/Number

Track view / Focused Track Text
Focused Track Name text color, and also Selected Track Number text color:

Also used in:

(other places - . see complete list)

Console view / Track names and numbers / Track Name Background Focused
This image is the focused track name text background color:

It is easy to end up with unreadable text here. Be careful and co-ordinate with Track View / Focused Track Background, which is a 
color, not an image. 

Track view / Unfocused Track Text
The Track number or Hardware output name:

Also used in:

(other places - see complete list)

Console view / Track names and numbers / Audio Track Name Text
Looks like it is used for Audio, Instrument, and MIDI tracks:
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Console view / Track names and numbers / Synth Track Name Text

Console view / Track names and numbers / Bus Name Text

Console view / Track names and numbers / Track Name Background
Unfocused track name background. Used for Inspector, tracks, busses, hardware: 

Console view / Track names and numbers / Track Number Background
The item image contains both selected and un-selected variations, illustrated here by tinting in different shades of pink:

Console view / Track names and numbers / Track Number Background (narrow)
The item image contains both selected and un-selected variations, illustrated here by tinting in different shades of pink:
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Note that "selected" and "focused" are distinct states: In the image above, Track 2 is selected; Track 4 is focused.

#ToDo: What controls the Track Number Text color for selected tracks?

Console view / Modules / Track ID / Audio Track Name Background Not used
Console view / Modules / Track ID / MIDI Track Name Text Not used
Console view / Modules / Track ID / MIDI Track Name Background Not used
Console view / Modules / Track ID / Instrument Track Name Text Not used
Console view / Modules / Track ID / Instrument Track Name Background Not used
Console view / Modules / Track ID / Synth Track Name Background Not used
Console view / Modules / Track ID / Bus Name Background Not used
Console view / Modules / Track ID / Hardware Output Name Text Not used
Console view / Modules / Track ID / Hardware Output Name Background Not used
These elements do not appear to be used.

6. Inspector

Inspectors / Frame Header 2x 
Inspectors / Frame Header 1x 

Inspectors / Frame Footer x2 
Inspectors / Frame Footer x1

Inspectors / Frame (collapsed)

Console view / Control Text and Values
Used for the collapsed frame title text:
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Global / View Border 

Also used by:

(other places - see complete list)

Inspectors / Arranger Tab
Inspectors / Arranger Tab (small)
Inspectors / Arranger Tab (collapsed)
Inspectors / Clip Tab
Inspectors / Clip Tab (small)
Inspectors / Clip Tab (collapsed)
Inspectors / Track Tab
Inspectors / Track Tab (small)
Inspectors / Track Tab (collapsed)
Inspectors / Bus Tab
Inspectors / Bus Tab (small)
Inspectors / Bus Tab (collapsed)
Inspectors / ProChannel Tab
Inspectors / ProChannel Tab (small)
Inspectors / ProChannel Tab (collapsed)
Inspectors / MixStrip Tab
Inspectors / MixStrip Tab (small)
Inspectors / MixStrip Tab (collapsed)

Inspectors / Display Menu
The second version of the image in the graphic (depressed? Mouse click?) does not appear to be used.

Inspectors / Audio Tab
Inspectors / MIDI Tab
These subsidiary tabs only show up when an Instrument track is selected, so that both the Audio and MIDI properties can be inspected:

Global / Horizontal Sliders 
Property value text and sliders:
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Also used in:

(other places - see complete list)

Global / Check Box Small ON
Global / Check Box Small OFF 

The Background and label Text colors can not be changed in the Theme Editor - at least, so  far we have not determined a way to do it.

6.1. MIDI Track Inspector

Inspectors / Chorus/Reverb Background
Inspectors / Snap To Scale Background
Inspectors / Snap To Scale Piano
Inspectors / MIDI Enable Button
States: 

[1] Inactive / Off
[2] Mouse down / click
[3] Mouse over / hover
[4] Active / On
[5] not available / disabled

Inspectors / MIDI Menu Pressed Not used / Not yet identified
Inspectors / MIDI Menu
This is used for both normal and "pressed" (actually doesn't depress, just displays the popup menu):

Inspectors / Input Quantize Background
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Inspectors / Arpeggiator Background
Inspectors / Arpeggiator Latch
One of the few cases where a unique button, including caption, is defined for an element.

Inspectors / Down Button
Inspectors / Up Button
Inspectors / Arpeggiator Lock Rate Button
Inspectors / Time+ Background

Inspectors / Patch Browser Button
One of the few cases where a unique button, including caption, is defined for an element.

Console view / Knob Unipolar
MIDI Mix; Chorus and Reverb:

Console View / Menu (pressed)
Console View / Menu
Pressed (Dark Pink) and un-pressed (Pink) buttons.

I'll re-iterate the comment from an earlier element:

When customizing these images, bear in mind that neither of them actually shows a different state 
when "pressed". You might wish to make them visually identical, or use some graphic technique to 
make them look different, but indicating a "pressed state" doesn't seem useful.

Both the "Menu" and "Menu (pressed)" images are used for distinctly different buttons. 
They might as well look functionally identical.
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6.2. Arranger Inspector

Console View / Background #1
As of the 2021.04 release, this theme element is also used to fill the background of the Arranger Inspector:

See also:

5. Console View

6.3. Tempo Inspector

Console View / Background #1
Tempo Inspector border:

See also:

5. Console View
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7. ProChannel

Global / Menus / View Menu Text
Header text, Insert Module menu text, and values:

Also used by:

(other places - see complete list)

Global / View Border
Insert Module menu background:

Global / Alternative Text #1
Selected module Header text color:

Track view / Unfocused Track Text
Preset name text color:

Also used in:

(other places - see complete list)

ProChannel / Preset Load
ProChannel / Preset Save As
ProChannel / Preset Background
This graphic theme element is only partially used to draw the UI:

This: results in this:

As determined by sjoens, the grey region is actually rendered using Console View / Unfocused Strip Background.
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ProChannel / Background Not used / Not yet identified
ProChannel / EQ Background Not used / Not yet identified
These may be obsoleted back when colored track strips were implemented.

ProChannel / EQ Plot

Note that the Narrow strip EQ plot is themed using:

Console View / Modules / ProChannel / EQ Plot (narrow)

ProChannel / Saturation Meter
ProChannel / Top Background
ProChannel / Add Module
ProChannel / Save Preset
ProChannel / Load Preset
ProChannel / Previous Preset
ProChannel / Next Preset
ProChannel / Zoom Module
ProChannel / Open ProChannel
ProChannel / Pre/Post Toggle
The five states are:

1. Inactive/Off    
2. Click    
3. MouseHover    
4. Active/On      
5. Disabled

Also used by:

5.2 Console view ProChannel Pre/Post toggle button

ProChannel / Global Meter
ProChannel / Saturation Meter
ProChannel / Enable
ProChannel / Switch (horizontal)
ProChannel / Switch (vertical)
ProChannel / Switch (horizontal inverted)
ProChannel / Clip Lamp
ProChannel / VU Background
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ProChannel / Missing
ProChannel / Compressor
ProChannel / EQ
ProChannel / Saturation
ProChannel / Compressor Meter
ProChannel / Routing Icon Compressor
ProChannel / Routing Icon EQ
ProChannel / Routing Icon Saturation
Console view / Track names and numbers / Track Number ProChannel Background
The element contains both selected and un-selected variations:

Console view / Track names and numbers / Track Number Inspector Background
This theme element contains both selected and un-selected variation, and is used when the ProChannel tab is active in the Inspector:
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7.1. ProChannel Modules

7.1.1. PC4K S-Type Bus Compressor

ProChannel / Modules / PC4K S-Type Bus Comp / Background
ProChannel / Modules / PC4K S-Type Bus Comp / Background
ProChannel / Modules / PC4K S-Type Bus Comp / VU Meter
ProChannel / Modules / PC4K S-Type Bus Comp / VU Meter Needle
ProChannel / Modules / PC4K S-Type Bus Comp / Ratio Knob

7.1.2. PC76 U-Type Channel Compressor

ProChannel / Modules / PC76 U-Type Channel Comp / Background
ProChannel / Modules / PC76 U-Type Channel Comp / Background
ProChannel / Modules / PC76 U-Type Channel Comp / VU Meter
ProChannel / Modules / PC76 U-Type Channel Comp / VU Meter Needle
ProChannel / Modules / PC76 U-Type Channel Comp / Ratio 4
ProChannel / Modules / PC76 U-Type Channel Comp / Ratio 8
ProChannel / Modules / PC76 U-Type Channel Comp / Ratio 12
ProChannel / Modules / PC76 U-Type Channel Comp / Ratio 20
ProChannel / Modules / PC76 U-Type Channel Comp / Ratio Inf
ProChannel / Modules / PC76 U-Type Channel Comp / Type
ProChannel / Modules / PC76 U-Type Channel Comp / Knob
ProChannel / Modules / PC76 U-Type Channel Comp / Screw

7.1.3. Equalizer

ProChannel / Modules / Equalizer / High
ProChannel / Modules / Equalizer / Hi Mid
ProChannel / Modules / Equalizer / HP Enable
ProChannel / Modules / Equalizer / Low
ProChannel / Modules / Equalizer / Lo Mid
ProChannel / Modules / Equalizer / LP Enable
ProChannel / Modules / Equalizer / Gloss
ProChannel / Modules / Equalizer / Style
ProChannel / Modules / Equalizer / Slope Knob

7.1.4. QuadCurve EQ

ProChannel / Modules / QuadCurve EQ / Background
ProChannel / Modules / QuadCurve EQ / Background (compact)
ProChannel / Modules / QuadCurve EQ / Background (lite)
ProChannel / Modules / QuadCurve EQ / Gloss
ProChannel / Modules / QuadCurve EQ / High
ProChannel / Modules / QuadCurve EQ / Hi Mid
ProChannel / Modules / QuadCurve EQ / HP Enable
ProChannel / Modules / QuadCurve EQ / Low
ProChannel / Modules / QuadCurve EQ / Lo Mid
ProChannel / Modules / QuadCurve EQ / LP Enable
ProChannel / Modules / QuadCurve EQ / Style
ProChannel / Modules / QuadCurve EQ / Slope Left Knob
ProChannel / Modules / QuadCurve EQ / Slope Right Knob
ProChannel / Modules / QuadCurve EQ / Hi Mid Knob
ProChannel / Modules / QuadCurve EQ / Hi Mid Knob Bipolar
ProChannel / Modules / QuadCurve EQ / Lo Mid Knob
ProChannel / Modules / QuadCurve EQ / Lo Mid Knob Bipolar
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ProChannel / Modules / QuadCurve EQ / Switch
ProChannel / Modules / QuadCurve EQ / Switch Inverted
ProChannel / Modules / QuadCurve EQ / Graph Scale 0-6
ProChannel / Modules / QuadCurve EQ / Graph Scale 0-12
ProChannel / Modules / QuadCurve EQ / Graph Scale 0-18

Inspectors / ProChannel / Modules / QuadCurve EQ / Lo Label 
Inspectors / ProChannel / Modules / QuadCurve EQ / Lo Mid Label 
Inspectors / ProChannel / Modules / QuadCurve EQ / Hi Mid Label 
Inspectors / ProChannel / Modules / QuadCurve EQ / High Label 
These color elements are used for the EQ parameter text labels. In the image below, I've used PINK for the Lo Label but they each 
work the same way:

Only one image needed to illustrate this, I think.

7.1.5. QuadCurve Equalizer fly-out

ProChannel / Modules / QuadCurve EQ fly-out / Background
ProChannel / Modules / QuadCurve EQ fly-out / Shadow Bottom Left
ProChannel / Modules / QuadCurve EQ fly-out / Shadow Bottom
ProChannel / Modules / QuadCurve EQ fly-out / Shadow Bottom Right
ProChannel / Modules / QuadCurve EQ fly-out / Shadow Right
ProChannel / Modules / QuadCurve EQ fly-out / Shadow Top Right
ProChannel / Modules / QuadCurve EQ fly-out / Pin Zoom Window
ProChannel / Modules / QuadCurve EQ fly-out / Close Zoom Window

Also used as the close box icon in the Add Track Flyout dialog, and the Browser Set Properties dialog.
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ProChannel / Modules / QuadCurve EQ fly-out / Low Band Gain Knob
ProChannel / Modules / QuadCurve EQ fly-out / Lo Mid Band Gain Knob
ProChannel / Modules / QuadCurve EQ fly-out / Hi Mid Band Gain Knob
ProChannel / Modules / QuadCurve EQ fly-out / High Band Gain Knob
ProChannel / Modules / QuadCurve EQ fly-out / Low Band Knob
ProChannel / Modules / QuadCurve EQ fly-out / Lo Mid Band Knob
ProChannel / Modules / QuadCurve EQ fly-out / Hi Mid Band Knob
ProChannel / Modules / QuadCurve EQ fly-out / High Band Knob
ProChannel / Modules / QuadCurve EQ fly-out / Switch
ProChannel / Modules / QuadCurve EQ fly-out / HP Enable
ProChannel / Modules / QuadCurve EQ fly-out / LP Enable
ProChannel / Modules / QuadCurve EQ fly-out / Gloss
ProChannel / Modules / QuadCurve EQ fly-out / Meter
ProChannel / Modules / QuadCurve EQ fly-out / Enable
ProChannel / Modules / QuadCurve EQ fly-out / Style

7.1.6. Tube Saturation

ProChannel / Modules / Tube Saturation / Background
ProChannel / Modules / Tube Saturation / Background
ProChannel / Modules / Tube Saturation / Type Switch

7.1.7. Categories

ProChannel / ProChannel Category / Default Category
ProChannel / ProChannel Category / Frequency Category
ProChannel / ProChannel Category / Dynamics Category
ProChannel / ProChannel Category / Simulation Category
ProChannel / ProChannel Category / Distortion Category
ProChannel / ProChannel Category / Time Category
ProChannel / ProChannel Category / Modulation Category
ProChannel / ProChannel Category / Imaging Category
ProChannel / ProChannel Category / FX Chain Category
ProChannel / ProChannel Category / Analysis Category

7.1.8. Menu Icons

ProChannel / ProChannel Menu Icons / PC4K Bus Compressor Menu Icon
ProChannel / ProChannel Menu Icons / PC76 Compressor Menu Icon
ProChannel / ProChannel Menu Icons / Tube Saturation Menu Icon
ProChannel / ProChannel Menu Icons / FX Chain Menu Icon
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8. FX Chains

The appearance of this dialog is not controlled by the current Theme. The UI can be customized from inside Cakewalk. A variety of 
default images are available, see C:\Cakewalk Content\Cakewalk Core\FX Chain Graphics.

More here: Cakewalk manual > Effects Chains > Customizing the FX Chain UI

FX Chains / In separator
FX Chains / Out separator
FX Chains / Separator
FX Chains / Next button
FX Chains / Previous button
FX Chains / Vintage Bright button
FX Chains / Fader
FX Chains / Fader background
FX Chains / Vintage Bright knob
FX Chains / Routing power
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8.1 ProChannel FX Chain module

FX Chains / ProChannel Module / Header Background Top

FX Chains / ProChannel Module / Controls Background

FX Chains / ProChannel module / Page Button
FX Chains / ProChannel module / Button
FX Chains / ProChannel module / Fader Background
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9. Piano Roll View
Default appearance of the Piano Roll view (PRV):

You can hide the Velocity/Controller pane by pressing the Collapse button:

This will show the velocity handles in-line with the notes, and reveal the Notes/Velocity options drop-down control at the top left:

Loop Construction / Resolution Menu
This element is  used to paint the Notes/Velocity drop-down menu:

Note  - the text color of the menu can not be changed.

Also used in:

Loop Construction view (duh)
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Global / Toolbar Background
The Window background color:

Also used in:

(other places - see complete list)

Global / Note Draw Duration Buttons / Whole
Global / Note Draw Duration Buttons / 1/2
Global / Note Draw Duration Buttons / 1/4
Global / Note Draw Duration Buttons / 1/8
Global / Note Draw Duration Buttons / 1/16
Global / Note Draw Duration Buttons / 1/32
Global / Note Draw Duration Buttons / Triplet
Global / Note Draw Duration Buttons / Dotted

The Piano Roll View Grid Line colors are controlled elsewhere, under Global items:

Global / Major Rules 

Global / Beat Rules 
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Global / Grid Rules 

Piano Roll view / Grid Background

Piano Roll view / Grid Label Background
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Piano Roll view / Black Keys Background (Db/Eb)
Piano Roll view / Black Keys Background (Gb/Ab/Bb)

Piano Roll view / PRV Aim Assist line 

Piano Roll view / Muted MIDI Clip Data 
Remember to disable the "Hide Muted Clips" option in order to see this theme element in use:

The defaul RGB value for this theme element is sub-optimal in both Mercury and Tungsten themes. @Starship Krupa recommends a 
grey tone, adjusted for taste. I agree. (See below for more.)

Piano Roll view / PRV Drag Contents

9. Piano Roll View Page  91



Track view / Focused Track Background
This color is used as a base for the highlighted name of the continuous controller which has the focus. Note that the color used is not as 
intense or bright as the original on which it is based.

Also used by:

(other places - see complete list)

Piano Roll view / Continuous Event 1
Piano Roll view / Continuous Event 2
Piano Roll view / Continuous Event 3
Piano Roll view / Continuous Event 4
Piano Roll view / Continuous Event 5
Piano Roll view / Continuous Event 6
Piano Roll view / Continuous Event 7
Piano Roll view / Continuous Event 8

Shown above are temporary color alterations to Event 3 (left) and Event 5 (right), because those appeared to be the ones used by the 
two CC lanes I added. 

Piano Roll view / Transform Bounding Box
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Piano Roll view / PRV Snap Override
Piano Roll view / Snap Musical Menu
Piano Roll view / Snap to MIDI Events
Piano Roll view / Snap to Markers
Piano Roll view / Add New Controller
Piano Roll view / Transform Tool
Piano Roll view / Transform Tool Small
Piano Roll view / Transform Tool Soft
Piano Roll view / Transform Tool Soft Small
Piano Roll view / Transform Normal
Piano Roll view / Transform Soft
Piano Roll view / Show/Hide Controller Pane

(Color Pref) Snap To Scale Excluded Rows
For MIDI tracks where the Snap To Scale feature has been enabled, the 
notes that do not belong to the selected scale are "greyed out" but you 
can assign a different color (shown here in pink):

Concerning selected MIDI events

Cakewalk changes the color of selected MIDI note events in the PRV by referencing the Luminance value of the PRV Grid Background 
color. Via experimentation, I've determined that:

• For Luminance values < 120, the notes are hilighted in near-White.

• For Luminance values >= 120, the notes are highlighted by a dark version of the un-selected note color. 

This ensures that selected notes are visible whatever the background grid color.
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9.1 PRV Track Pane

Track view / Track Pane / Active Strip Background
This is the strip background of the selected track:

Also used by:

12. Staff view selected track background

Track view / Focused Track Background
This is the Focused Track Name background:

Also used in:

(see complete list)

Track view / Track Pane / Selected Track
Selected track number background color:

Track view / Track Pane / Strip Background
Un-selected, un-focused Track list strip background color:

Also used by:

12. Staff view un-selected track background
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Track view / Unfocused Track Text
Un-selected track text color:

Also used in:

(other places - see complete list)

Un-selected Track Name and Track Number Background

The un-selected Track Name Background and Track Number Background color appears to be hard-coded to 2C2C2C and does not have a 
corresponding Theme element. 

I would expect this UI element to be controlled by Track View > Unfocused Track Background, (also 2C2C2C) but it isn't. 

Compare this with Synth Rack Un-focused Synth Name Text background.

This does make color co-ordination of the PRV Track Pane and the Track View  Track Pane somewhat constrained.

Piano Roll view / Track Pane / Auto Focus
Piano Roll view / Track Pane / Auto Lock
Piano Roll view / Track Pane / Filter
Piano Roll view / Track Pane / Add track to filter
This icon indicates whether a track is included in the current filter. The four impressions are:

1. Not in filter

2. Not in filter, mouse hovering over 

3. In Filter

4. In Filter, mouse hovering over

Piano Roll view / Track Pane / Select track for editing

This icon indicates whether Track Events are visible and/or enabled for editing in the PRV. The image strip contains five 22 x 22 pixel 
gliphs, indicating:

1. Visible

2. Selected/Active track for editing

3. Not visible

4. Visible but read-only (in auto-lock mode)

5. Not visible (in auto-lock mode)
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10. Step Sequencer

Track view / Unfocused Track Text
Sequencer Value text color:

Also used in:

(other places - see complete list)

Step Sequencer / Step Button

From a Cakewalk User Forum post by @Starship Krupa:

The Step Sequencer divides things into odd and even measures. Each step sequencer step can have 6 different states depending on 
whether it is in an odd or even measure, whether it's active (meaning you've clicked it to make a note sound), inactive (empty), and 
then whether it's highlighted because the playhead is currently over it. So if there are only 6 states, why do we have 12 cells? 

This is so rows of contiguous active steps can have rounded corners at each end. 

So in addition to all of the above, we also have images for the leftmost, middle, and rightmost active steps in a row, plus one for a 
single isolated step. This adds 3 button shapes plus their highlighted forms. 

Without further ado, I present the different cells of this button and what states they represent: 

Cell 1: Empty step in odd measure
Cell 2: Highlighted empty step in odd measure
Cell 3: Empty step in even measure
Cell 4: Highlighted empty step in even measure
Cell 5: Isolated step
Cell 6: Highlighted isolated step
Cell 7: Leftmost step in row of contiguous steps
Cell 8: Highlighted leftmost step
Cell 9: Inside step in row of contiguous steps
Cell 10: Highlighted inner step
Cell 11: Rightmost step in row of contiguous steps
Cell 12: Highlighted rightmost step 

Step Sequencer / Step Bar
Step Sequencer / Step Bar (Playing)

Step Sequencer / Step Button Bar (Off)
Step Sequencer / Step Button Bar (On)
These are used to display the "hexagrams" that appear atop active step buttons

Step Sequencer / Control Header Background
Step Sequencer / Control Ruler Background Top
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Step Sequencer / Control Ruler Background Bottom
Step Sequencer / Play Position Lamp
Step Sequencer / Track Background (Odd)
Step Sequencer / Track Background (Even)
Step Sequencer / Fit to Quarters
Step Sequencer / Mono/Poly Switch
Step Sequencer / Play
Step Sequencer / Step Record
Step Sequencer / Insert Row
Step Sequencer / Delete Row
Step Sequencer / Track Control Background
Step Sequencer / Track Control Background (selected)
Step Sequencer / Expand Row
Step Sequencer / Collapse Row
Step Sequencer / Value Spinner
Step Sequencer / Mute Button
Step Sequencer / Solo Button
Step Sequencer / Green Lamp
Step Sequencer / Orange Lamp
Step Sequencer / Track Control Background Expanded
Step Sequencer / Knob
Step Sequencer / Menu
Step Sequencer / Controller Background
Step Sequencer / Ruler Background Top
Step Sequencer / Ruler Background Bottom

10. Step Sequencer Page  97



11. Matrix view

Global / Horizontal Sliders 
Drop-down menu text color:

Also used in:

(other places - see complete list)

Matrix / Background Header Left
Matrix / Background Header
Matrix / Background Header Right
Matrix / Stop All Cells
Matrix / Capture Matrix Performance
Matrix / Follow Transport
Matrix / Trigger Resolution Menu
Matrix / Global Loop Mode
Matrix / Global Latch Mode
Matrix / Retrigger Mode
Matrix / Cell Start
Matrix / Cell MIDI Trigger Enable
Matrix / Matrix Options
Matrix / Column Trigger
Matrix / Row Background (empty)
Matrix / Row Background
Matrix / Row Background (selected)
Matrix / Direct Mode
Matrix / Row Mute
Matrix / Row Solo
Matrix / Row Destination Track Menu
Matrix / Cell Background (empty)
Matrix / Cell Background
Matrix / Cell Play
Matrix / Cell Loop Mode
Matrix / Cell Latch Mode
Matrix / Cell Trigger A/B
Matrix / Cell MIDI Learn
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12. Staff View

Global / View Border 

Also used by:

(other places - see complete list)

Global / Note Draw Duration Buttons / Whole
Global / Note Draw Duration Buttons / 1/2
Global / Note Draw Duration Buttons / 1/4
Global / Note Draw Duration Buttons / 1/8
Global / Note Draw Duration Buttons / 1/16
Global / Note Draw Duration Buttons / 1/32
Global / Note Draw Duration Buttons / Triplet
Global / Note Draw Duration Buttons / Dotted

Time Ruler / Track View Time Ruler Digits 

Also used in:

(see complete list)

Track view / Track Pane / Active Strip Background
Selected track background color:

Also used by:

9.1. Piano Roll view focused track background
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Track view / Track Pane / Strip Background
Un-selected track background color:

Also used by:

9.1. Piano Roll view un-focused track background

Track view / Unfocused Track Text
Un-selected track text color:

Also used in:

(other places - see complete list)

Staff view / Zoom In
Staff view / Zoom Out
Staff view / Lyrics
Staff view / Chords
Staff view / Expression
Staff view / Hairpin
Staff view / Pedal
Staff view / Now Time Display

(Color Pref) Events
Used when drawing a new note/event in the Staff view:

(Color Pref) Note that is on
Highlighting events during play-back:

(Color Pref) Values
Selected notes/events in the Staff view:
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12.1. Guitar Fretboard

Staff view / Guitar / Rosewood Wood Grain (hi res)
Staff view / Guitar / Rosewood Wood Grain (lo res)
Staff view / Guitar / Ebony Wood Grain (hi res)
Staff view / Guitar / Ebony Wood Grain (lo res)
Staff view / Guitar / Maple Wood Grain (hi res)
Staff view / Guitar / Maple Wood Grain (lo res)
Staff view / Guitar / Pearl Fret Dots
Staff view / Guitar / Black Fret Dots
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13. Synth Rack View

Browser / Synth Rack / Insert Synth
Browser / Synth Rack / Delete Synth
Browser / Synth Rack / Insert Synth Options
Browser / Synth Rack / Synth Properties

Browser / Synth Rack / Synth Strips / Synth Name Text 
This color is used in the drop-down menu icon:

It is also used for the bank/patch information 

for the un-docked Synth Rack:

Browser / Synth Rack / Synth Strips / Connect/Disconnect Synth (undocked)
That's the round blue button in the image on the left, above.

Global / View Border

Also used in:

(other places - see complete list)

Track view / Focused Track Text
Focused synth name text

Also used in:

(other places - . see complete list)

Track view / Focused Track Background
Focused synth name background:

Also used in:

(see complete list)
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Track view / Audio Track Name Text
Un-focused Synth Name text:

As of 2020.08: The unfocused Synth Name background color is 2C2C2C 
and does not appear to have a corresponding Theme element.

Also used in:

3.4. Track view Track Strip un-focused Audio Track name text

Global / Menus / View Menu Text
Drop-down menu text color:

Also used in:

(other places - see complete list)

Browser / Media Browser / Content Location Menu
Synth automation Drop-down menu:

Also used in:

4. Media Browser content location menu

Browser / Synth Rack / Synth Strips / Synth Name Bezel (undocked)
The portion of the display not used for the Synth Name shows the Bezel image as background to the patch instance detail:

Browser / Synth Rack / Synth Strips / Synth Name Bezel (docked) No longer used as of 2020.08

As of version 2020.08, the docked Synth Rack does not use Synth Name Bezel theme element for displaying the synth name. This 
makes it easier to identify the selected Synth row, and is consistent with "selected" items in the Track view.

Browser / Synth Rack / Synth Strips / Previous Preset
Browser / Synth Rack / Synth Strips / Next Preset
Browser / Synth Rack / Synth Strips / Assign Controls
Browser / Synth Rack / Synth Strips / Show/Hide Assigned Controls
Browser / Synth Rack / Synth Strips / Linear Knob
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14. AudioSnap

Track view / Unfocused Track Text
Drop-down menu value text:

Also used in:

(other places - see complete list)

AudioSnap / AudioSnap Pool Lines
AudioSnap / Musical Snap Pool Lines
AudioSnap / Snap Assist Line
AudioSnap / Active Snap Assist Line

14.1 AudioSnap Palette

AudioSnap / Palette / Background
AudioSnap / Palette / Enable/Disable AudioSnap on Selected Clips
AudioSnap / Palette / Copy AS MIDI
AudioSnap / Palette / Split Beats Into Clips
AudioSnap / Palette / Set Clip Time Base
AudioSnap / Palette / Set AudioSnap Options
AudioSnap / Palette / Set Project Tempo From Clip
AudioSnap / Palette / Clip Follows Project
AudioSnap / Palette / Edit Clip Map
AudioSnap / Palette / Quantize
AudioSnap / Palette / Extract Groove
AudioSnap / Palette / Apply Groove
AudioSnap / Palette / Menu Arrow
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15. Loop Construction

Global / Toolbar Background

Also used in:

(other places - see complete list)

Global / Menus / View Menu Text
Toolbar text labels:

Also used by:

(other places - see complete list)

Track view / Unfocused Track Text
Toolbar values:

(When Loop is active; otherwise, values are painted in Disabled Control Text)

Also used in:

(other places - see complete list)

Loop Construction / Play
Loop Construction / Loop
Loop Construction / Resolution Menu

Also used in:

PRV Notes/Velocity menu

Loop Construction / Pitch
Loop Construction / Pitch Drop-down Menu
Both elements are shown here:
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Global / Window Text
Ruler digits:

Also used by:

16. Event List view footer text

Time Ruler / Track View Time Ruler Digits 
Ruler tick marks:

Also used in:

(see complete list)

Time Ruler / Time Ruler Background 
Window background:

Also used in:

(other places - see complete list)

Time Ruler / Markers / Markers
0 db and channel divider lines:

Also used in:
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Track View Time Ruler

15. Loop Construction Page  107



16. Event List

Global / Window Background
List background color:

Also used by:

21. Temp view grid background

Time Ruler / Time Ruler Background 
Column header background color:

Also used in:

(other places - see complete list)

Global / Menus / View Menu Text
Column header title text:

Also used by:

(other places - see complete list)

Time Ruler / Track View Time Ruler Digits 
Column header outline:

Also used in:

(see complete list)

Meter/Key view / Insert
Meter/Key view / Delete

Also used in:

20. Markers view

22. Meter/Key view
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Event List / Note Events
Notice that this affects "note" event text only. Other types of events are colored differently:

There are quite a few types of events:

The pink rows are note events. Lyrics are purple; controllers are orange; etc. These colors can be changed in the Preferences > Colors:

(Color Pref) Event List ChanAftEvents
(Color Pref) Event List Control Events
(Color Pref) Event List KeyAft Events
(Color Pref) Event List Note Events
(Color Pref) Event List Patch Events
(Color Pref) Event List Special Events
(Color Pref) Event List Sysx Events
(Color Pref) Event List Wheel Events

Global / Window Text
Footer text color:

Also used by:

15. Loop Construction view Ruler Digits
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17. Lyrics

Global / Toolbar Background

Can the text/background colors be changed? Probably not.

Also used in:

(other places - see complete list)

18. Video
The user can customize the font, font color, and background color from within the application, via right-click context menus. There are 
no theming elements involved.

19. Big Time
The user can customize the font, font color from within the application, by clicking in the window. There are no theming elements 
involved. I don't believe the background color can be changed.
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20. Markers

Global / Menus / View Menu Text
Column title text:

Also used by:

(other places - see complete list)

Time Ruler / Time Ruler Background 

Also used in:

(other places - see complete list)

Markers / Lock/Unlock Marker

This is the button in the toolbar that sets the current marker row as locked to SMPTE 
time, and won't move even if the Tempo of the project is changed.

Markers / Marker Lock Indicator
The "lock" indicator appears against locked rows (see image above)

2020.04 Note:

There was a bug fix documented against the 2020.04 release of Cakewalk that said: "Marker view 'Lk' column does not show locked 
status in Tungsten theme."  This was accompanied by a PSA stating "Existing custom themes may not display properly in version 
2020.04 until the themes have been updated. If you use custom themes, please be aware of the following additions/changes in Theme 
Editor:", and included in the list was the Markers view "Marker Lock Indicator".

Subsequent to that change, none of my custom themes were displaying the Lk mark against Marker rows. It's almost as though the bug 
fix in the product had prevented default Marker Lock Indicator elements from being used correctly. 

Currenly, the solution appears to be that if you create a custom theme, you MUST include a custom Marker Lock Indicator, otherwise 
it won't be visible.

Meter/Key view / Insert
Meter/Key view / Delete
Meter/Key view / Properties

Also used in:

16. Event List view

22. Meter/Key view
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21. Tempo view (Obsolete from 2021.04 on)

NOTE: As of release 2021.04, the Tempo View has been replaced with a special track in the Track View, the Tempo Track. So this 
chapter is retained here for historical reasons, for now, but may be removed at a later date.

Global / Toolbar Background

Also used in:

(other places - see complete list)

Global / Menus / View Menu Text

Also used by:

(other places - see complete list)

Global / Window Background

Also used by:

16. Event List view list background
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Tempo view / Rules

Tempo view / Insert Tempo
Tempo view / Delete Tempo

Also used by:

16. Event List view

20. Markers view

22. Meter/Key view

Tempo view / Tempo Properties
Also used by:

22. Meter/Key view

Tempo view / Tempo List

(ColorPref) Drawing
This color is used to shade the area under the mouse-drawn curve when editing the Tempo curve with the mouse:
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22. Meter/Key

Meter/Key view / Insert
Meter/Key view / Delete
Meter/Key view / Properties

Also used in:

16. Event List view

20. Markers view

Time Ruler / Time Ruler Background

Also used in:

(other places - see complete list)
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23. Sysx

Time Ruler / Time Ruler Background
Window background:

Also used in:

(other places - see complete list)

24. Navigator

Navigator / Background

Also:

(Color Pref) Navigator Track Rectangle

25. Surround Panner

Surround / Large Surround Panner
Surround / Speaker 0
Surround / Speaker 0 Off
Surround / Speaker 30
Surround / Speaker 30 Off
Surround / Speaker 45
Surround / Speaker 45 Off
Surround / Speaker 60
Surround / Speaker 60 Off
Surround / Speaker 90
Surround / Speaker 90 Off
Surround / Menu
Surround / LFE Button
Surround / Surround Quad
Surround / Surround 5.1
Surround / Surround 6.1
Surround / Surround LRCS
Surround / Surround LCR
Surround / Surround XXX
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26. Virtual Controllers

Virtual Controller / Piano Key Range
Virtual Controller / Background
Virtual Controller / Modulation 1
Virtual Controller / Modulation 2
Virtual Controller / Modulation 3
Virtual Controller / Modulation 3
Virtual Controller / Modulation 4
Virtual Controller / Modulation 5
Virtual Controller / Hold (Tab)
Virtual Controller / W
Virtual Controller / E
Virtual Controller / T
Virtual Controller / Y
Virtual Controller / U
Virtual Controller / O
Virtual Controller / P
Virtual Controller / A
Virtual Controller / S
Virtual Controller / D
Virtual Controller / F
Virtual Controller / G
Virtual Controller / H
Virtual Controller / J
Virtual Controller / K
Virtual Controller / L
Virtual Controller / Semi-Colon
Virtual Controller / Apostrophe
Virtual Controller / Octave Down (Z)
Virtual Controller / Octave Up (X)
Virtual Controller / Velocity Down (C)
Virtual Controller / Velocity Up (V)
Virtual Controller / Play/Stop (Spacebar)
Virtual Controller / Octave Down (Left Arrow)
Virtual Controller / Velocity Up (Up Arrow)
Virtual Controller / Velocity Down (Down Arrow)
Virtual Controller / Octave Up (Right Arrow)

26.1. Virtual Piano
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Virtual Controller / Piano / Sustain (Hold)
Virtual Controller / Piano / Octave Down
Virtual Controller / Piano / Piano Keys Unlit
Virtual Controller / Piano / Piano Keys Lit
Virtual Controller / Piano / Octave Up
Virtual Controller / Piano / Take All Keystrokes

27. Play List view

Play List / Enable Play List
Play List / Next Song
Play List / Repeat List
Play List / Add Song
Play List / Remove Song
Play List / Delay
Play List / Keep Focus on Top
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28. Help Module

Track view / Unfocused Track Text 

The background is most likely not themable.

Also used in:

(see complete list)
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29. Icons
An application re-start may be required to refresh these theme elements in the UI.

29.1. Track icons
These are the larger icons that optionally appear in the Track Strip and Console Icon module; and also the Synth Rack.

• Transparency is NOT respected, but filled with BLACK.

• A faint white border will be drawn around the image

Icons / Track icons / Audio Track Icon
Icons / Track icons / MIDI Track Icon
Icons / Track icons / Instrument Track Icon
Icons / Track icons / Synth Track Icon
I have to tell you that it bothers me that these aren't the other way around. It just seems more logical to me that an Instrument track, 
which combines MIDI data with the VSTi audio output, wouldn't use the icon with both instrument and MIDI icons.

In my custom themes, I tend to swap these:

Icons / Track icons / Aux Track Icon
Icons / Track icons / Bus Icon
Icons / Track icons / Surround Bus Icon
Icons / Track icons / Hardware Out Icon
Icons / Track icons / Track Folder Icon
Icons / Track icons / Video Thumbnail Icon

29.2. Track Header icons
These are the smaller icons that appear in the minimized Track Strip.

• Transparency is respected.

Icons / Track Header icons / Audio Track Header Icon Stereo Not used?
Icons / Track Header icons / Audio Track Header Icon Stereo
I don't know why there are two identically-named elements. My tests seem to indicate the second one is actually used.

Icons / Track Header icons / Audio Track Header Icon Mono
Icons / Track Header icons / Audio Track Header Icon Mono Frozen
Icons / Track Header icons / Audio Track Header Icon Mono Thawed
Icons / Track Header icons / Audio Track Header Icon Stereo Frozen
Icons / Track Header icons / Audio Track Header Icon Stereo Thawed

Icons / Track Header icons / MIDI Track Header Icon Not Used?
Icons / Track Header icons / MIDI Track Header Icon
I don't know why there are two identically-named elements. My tests seem to indicate the second one is used.

Icons / Track Header icons / MIDI Track Header Icon Frozen
Icons / Track Header icons / MIDI Track Header Icon Thawed
Icons / Track Header icons / Synth Track Header Icon
Icons / Track Header icons / Synth Track Header Icon Frozen
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Icons / Track Header icons / Synth Track Header Icon Thawed
Icons / Track Header icons / Instrument Track Header Icon
Icons / Track Header icons / Instrument Track Header Icon Frozen
Icons / Track Header icons / Instrument Track Header Icon Thawed
Icons / Track Header icons / Bus Header Icon
Icons / Track Header icons / Surround Bus Header Icon
Icons / Track Header icons / Track Folder Header Icon
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30. Plug-in Property page

Global / Toolbar Background

Also used in:

(other places - see complete list)

Plug-in property page / Host Bypass button

Plug-in property page / Preset Name drop-down menu
The first cell in the image is its standard state, the second is what's displayed after the user double clicks on it to change the preset 
name. It persists until the preset is saved. Whatever color you use for both cells should have good contrast with View Menu Text.

- @StarshipKrupa

Plug-in property page / Decrement Preset button
Plug-in property page / Increment Preset button
Plug-in property page / Save Preset button
Plug-in property page / Delete Preset button
Plug-in property page / VST Preset Options button
Plug-in property page / ACT Learn button
Plug-in property page / Access Piano Roll
Plug-in property page / Access Staff View
Plug-in property page / Access Event List
Plug-in property page / Access Step Sequencer
Plug-in property page / Solo button
Plug-in property page / Automation Read
Plug-in property page / Automation Write
Plug-in property page / Give all Keystrokes to Plug-in
Plug-in property page / Pin Plugin Window
Plug-in property page / Link Surround Automation Controls

30.1 Control Surface Property Page

Plug-in property page / Control Surface / ACT Learn OFF
Plug-in property page / Control Surface / ACT Learn ON
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31. External Insert
This is a plug-in that can be inserted into the FX Bin.

External Insert / External Insert background

31. External Insert Page  123



32. VocalSync
TBD

VocalSync / VocalSync background
VocalSync / Bypass button
VocalSync / Close button
VocalSync / Guide Track menu
VocalSync / Strength knob
VocalSync / NF knob
VocalSync / NF button
VocalSync / Apply button
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33. Step Record

Step Record / Whole Note
Step Record / 1/2 Note
Step Record / 1/4 Note
Step Record / 1/8 Note
Step Record / 1/16 note
Step Record / 1/32 Note
Step Record / 1/64 Note
Step Record / Dotted Note Step
Step Record / Double Dotted Note Step
Step Record / Custom Value
Step Record / Step Backward
Step Record / Step Advance
Step Record / Beat Backward
Step Record / Beat Advance
Step Record / Measure Backward
Step Record / Measure Advance
Step Record / Switch to Advanced Mode
Step Record / Switch to Basic Mode
Step Record / Activate Step Record

See https://bandlab.github.io/cakewalk/docs/Cakewalk%20Reference%20Guide.pdf#M7.9.25530.Head.1.Step.Recording
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B. Techniques & Case Studies

Theme Editor Tips and Tricks

Use two instances of the Theme Editor
You can open two instances - or more - of the theme editor at once, and copy-and-paste items between two different themes. Very 
useful!

You can paste image data from the Windows clipboard directly into Theme Editor
This might be obvious but it was a revelation to me when I realized I didn't need to "EDIT" a UI Element in my graphic editor in order to 
update it.

Instead, in my image editor application I can select the set of pixels from my master graphic image (remember to FLATTEN all layers), 
COPY, then highlight the element in the Theme Browser and Ctrl-V to PASTE directly over the current image.

This probably only works if the image data is of the correct type (32-bit PNG) and dimensions.

Known Bugs
Refreshing the UI after changing a theme ideally requires re-starting Cakewalk. Merely switching themes in an open instance of 
Cakewalk may not fully respect the theme changes. Clearly there's some caching going on. 

Importing changes from one theme into another does not always include all changed items. Use with caution and double-check the 
results.
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Special Themes

COLOR_TEST

Every time I discover a theme element that I suspect to be obsolete or unused, I 
update my COLOR_TEST theme to highlight the element in bright flourescent 
green.

This makes it really easy to tell when I've made a mistake - it shows up very 
clearly if it turns out it really is visible under some circumstance...

It's also a handy starting point for new themes because you don't need to waste 
time on elements that aren't used or visible in the UI.

PURPLETRATOR

In order to definitively find out whether an UI feature can be themed or not, I use 
a theme named "PurpleTrator" where every color has been set to purple. 

All non-obvious graphics have also been set to purple areas.

When using Cakewalk with the PURPLETRATOR  theme, it may be blinding but it is 
also easy to what parts of the UI are static. There's a bunch of lines and 
backgrounds and text which just aren't able to be changed.

Note that, in this screen shot, there are many graphic elements that haven't been 
changed from default. It looks worse than it is! Also it would be impossible to 
navigate around if everything were the same color, including the images.
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Control Bar
I have not found the correct attribute to change to control the background of the Control Bar. However we can work around this.

"Tungsten Slate"

I quite like this effect where each module is clearly distinct, even when the "center and justify" option is selected. This is actually a 
minimal customization of "Tungsten": The only thing changed is the Background (large) item for each module, flood-filling with the 
slate blue color. 

For example, the MixRecall module:

Note that the image actually has a transparent border on three sides, and we are not changing that.  Our blue-grey fill is constrained to 
the existing border.

This is cool. I went ahead and customized the remaining background images for the modules (for medium and small sizes), but after I'd 
finished, the Control Bar suddenly changed:

See how the background is now a continuous slate blue instead of the individual modules position on a black background? This is a nice 
look, but something must have triggered this rendering difference...

On a hunch, I reverted the following images from Control Bar | Modules, and saved the theme:

Custom | Background (medium)
Custom | Background (small)

Now I see:

Of course, the Custom module now doesn't have the slate blue background at medium and small sizes, as expected.

When I carefully re-implemented the slate blue background for the Custom | Background (medium) item, the Control Bar 

background once again flood-filled with the blue.
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It is only the (medium) size that exhibits this side-effect. Setting a custom background color on the (small) background behaves as 
expected.

This is almost certainly a bug but it does give us a way to flood-fill the Control Bar Background with a specific color... it just has to be the 

color of that image (Custom | Background (medium)). Here, I set it to blue:

Yeah, although this behavior probably won't change, I don't think I'll be leveraging it.

Aside

Interesting - in the example on the previous page, do you see how the custom buttons have also changed color? This is a feature of how 

the custom button item is implemented in Tungsten. (See 4.15 above for a detailed comparison with Mercury).

This gives me an idea... what if we revert all of the background images (normal, medium, small) and instead, adjust the button image to 
use the slate blue color:

This results in the following:

You know, that's 
pretty sexy. The mouse is hovering over the CLP button of course.

How does this look if we try some other Control Bar display modes?

Normal: 

Lock order and Justify:

Nice. I like it. I think that's a keeper.

About that Custom Medium Background
Just for kicks, I altered the default MERCURY background image for "Custom (medium)" 
to put a diagonal line across it, thus:

The Control Bar results in "locked, centered" mode were interesting:

The left and right half of the background image is used at the left and right ends of the Control Bar, and a middle strip of the image - 
perhaps 1 pixel wide - is used to fill out the remaining gaps.

Note the use of the left and right sides of the image a second time just at the beginning and end of the first and last modules.
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Button States
Theme elements for push buttons in general follow a template: a series of images representing Normal, Clicked, Mouse-over, Active, 
and Disabled and/or Not Applicable. Sometimes there are variations on this, as you’ve seen if you’ve reviewed Section A.

Control Bar module buttons also follow this pattern, but due to the way they are used in the user interface, the default use of colors is 
not always best for the user experience.

Momentary On buttons
For example, consider the Select button in the Tools module. 

If we distinctly mark each impression in the strip:

Now we can then observe how the impressions are used as we open and use the Cakewalk application:

Loading: Normal: Mouse-Over: Click/Mouse-Down: Active/Enabled:

5 1 3 2 4

That’s fine. But other modules don’ work that way. 

Consider the Markers module:

Loading: Normal: Mouse-Over: Click/Mouse-Down: Active/Enabled:

(not used)

5 1 3 2 4

The Marker buttons are only used in a momentary operation. Perhaps it would improve the user experience if the “blue, active” 
impression was actually used in Slot 2? How many other “momentary” or non-default button operations could be tweaked for better 
experience?

Control Bar / Modules / Loop / Set Loop Points to Selection
Original Recommended (from MIL-SPEC ALPHA theme):

Control Bar / Modules / Select / Set From = Now
Control Bar / Modules / Select / Set Thru = Now

Original Recommended (from MIL-SPEC ALPHA theme):
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Control Bar / Modules / Markers / Previous Marker
Control Bar / Modules / Markers / Next Marker
Control Bar / Modules / Markers / Insert Marker

Original Recommended (from MIL-SPEC ALPHA theme):

Track view / Track Pane / Duplicate Track button
Original Recommended (from MIL-SPEC ALPHA theme):

Track view / Add Track flyout / Add Track button
Original Recommended (from MIL-SPEC ALPHA theme):

Another example would be the Now time seeker controls:

Control Bar / Modules / Transport / RTZ
Original Recommended (from MIL-SPEC ALPHA theme):

Menu buttons
Consider the Edit Filter button:

Observe in operation:

Normal: Mouse-Over: Click/Mouse-Down: Mouse Up:

I haven’t observed State 4 but it is possible it is used. One could argue that the “mouse down” state 2 should be more obvious:

Track View / Track Pane / Edit Filter
Original:

Recommended:
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Selection Markers in the Track Ruler
Something interesting I noticed recently is Ruler background and Selection Markers interaction. Some kind of color inversion is used to 
highlight the selected zone duration, which is perfectly acceptable. But the colors used to render the selection and loop markers are not 
exactly the same as the colors chosen in the Theme Editor.

Mercury default:

Tungsten default:

Custom theme:

Conclusions:
Background and Marker colors seem to be legit, but for some reason, the SELECTION markers will be rendered with a less-saturated 
version of the Theme color. Are they applied with an Alpha-channel < 255 ? 

I recommend testing and avoiding subtle variations between colors. This may limit our creativity a little.
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Selected and Focused Tracks
It seems like a simple customization: to change the color of a "selected" track. How hard can it be? Unfortunately, it's trickier than you'd 
expect.

In Mercury, we have the following states: 

NORMAL, SELECTED, and FOCUSED.

Cakewalk highlights the Track Number for selected tracks.

Cakewalk highlights the Track Name for focused tracks.

Focused tracks can be Selected, or Un-selected:

The highlighting used for Focus and Selection can be customized 
independently. 

Selected Tracks
First, let's look at what we need to consider when changing the highlight background color used for SELECTED trac ks.

Track view / Track Pane / Selected Track (more info)
Color = 99DD33 (green)

Console view / Track names and numbers / Track Number Background (more info)
Console view / Track names and numbers / Track Number Background (narrow)
Console view / Track names and numbers / Track Number ProChannel Background (more info)
Console view / Track names and numbers / Track Number Inspector Background (more info)

The results look great:
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That's about the smallest possible customization. We haven't attempted to change the text color, or change to a "light on dark" 
selection style.

One complexity is the relationship between the text/foreground colors: 

Track view / Track View Header Selected Track Number (more info)
Controls the text color of the Track View Selected Track Number

Track view / Focused Track Text (more info)

Controls the text color of the Track View Focused Track Name

Track view / Focused Track Text (more info)
Controls the text color of the Console View Focused Track Name and Selected Track Number.

For Track view, Focused and Selected text colors are independent. For Console view, they are the same. This is not a problem if all you 
want to do is adjust the background color of Focused tracks to be another light color shade:

Focused Tracks

Track view / Focused Track Background (more info)
Color = BEE08D (pale green)

Console view / Track names and numbers / Track Name Background Focused (more info)

Results:

Okay perhaps a lighter shade of green would have been better to distinguish them. Or, maybe that's the look we're going for? You 
decide.

Time ruler / Selection Markers (more info)
Change this to match your selection color if you're super-keen to co-ordinate "selections" of all kinds.
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Clip Colors
One of the first things I did after playing around with color options in earlier versions of Cakewalk was to try and make the clips look like 
other DAWs that I admired. This can be an uphill battle because Cakewalk doesn't expose every possible color used by the application 
to indicate clip state. And there are a lot of Cakewalk-specific factors:

You have to consider:

• Clip headers and names;

• Clip fades and cross-fades;

• Selected and or Muted clips ;

• Archived and Frozen tracks

• ...and probably more.

For clarity, you're really better off exploring the possibilities within the "Cakewalk way" of coloring clips. Obviously you can't stop a user 
from customizing the foreground and background colors on a per-clip- or -track basis, but you should try to make the defaults work in a 
reasonable way.

Gallery

Mercury (default)

Tungsten (default)

Almost the same as Mercury, although I think the default clip background is too dark - it's much harder to see the clip automation in the 
unselected clips at right.
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Boston Flowers (custom)

MarianoGF  obviously put some thought into how clips are default-colored, and it works:

Sonar 85 (custom)

Trance-Canada did a good job with this one: the clips are very clear, although one drawback is that light-colored backgrounds can make 
clip fades hard to see:

"White Clips" (experimental)

I used a bright white default background, and a pale green for "selected":
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Flat White (custom)

This is another example of experimenting with dark waveform colors and light background colors. Again, the clip fades are not so easy 
to see, except on SELECTED clips: 

Compare with View > Display > [X] Maximize Waveform Height:. It's hard to distinguish a selected clip until you're familiar with it:

NOTE: Clip Fade line color can not be customized in a Theme, but you can use Preferences > Colors to change the default color used 
for the curve line.
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Read Automation States
In order to determine how the Read Automation state buttons are used, I found it useful to create a special custom theme with the 
following button sets:

Control Bar / Modules / Mix / Read Automation

Track view / Track Pane / Read Automation

Track view / Track Pane / Global Read Automation

Console View / Modules / MSR / Read Automation

This allows us to more easily identify the images used in the UI.

Default State
By default, a new project has Global Read Automation enabled:

All the tracks are shown with the Read Automation state enabled:

Any specific track can have Read Automation disabled or supressed locally by clicking on the indicator button in the Track Pane or the 
Console. For example, Track 3:

At this point, we may decide to disable Read Automation globally across all tracks, by clicking on the button in the Mix Module:

We see the tracks change their status icons to indicate that Read Automation is disabled globally:

Interestingly, it appears that Cakewalk is simply using the "Global Read Automation" theme element to represent the track status in both 
Track View and Console view, each of which show 4,4,1 respectively.
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Automation Lanes can add complexity:

Now we can fill out our documentation:

Control Bar / Mix Module / Read Automation

1 - Global RA Disabled

2 - Mouse Push (when 1)

3 - Mouse Over (when 1)

4 - Global RA Enabled

5 - No Project Loaded

Track View / Track Pane / Read Automation

1 - RA Disabled on This Track

2 - (mouse push when 1)

3 - (mouse over when 1)

4 - RA Enabled 

5 - (mouse push when 4)

6 - (mouse over when 4)

7 - ?

8 - Indicates that there are multiple automation lanes with different Read Automation states (tri-state)

Console View / Modules / MSR / Read Automation

1 - Disabled on This Track

2 - (mouse push when 1)

3 - (mouse over when 1)

4 - Enabled 

5 - (mouse push when 4)

6 - (mouse over when 4)

7 - ?

8 - Indicates that there are multiple automation lanes with different Read Automation states (tri-state)

Track View / Track Pane / Global Read Automation  

Used in both Track Pane and Console View when Read Automation is disabled globally (=1)
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1 - RA Globally Disabled (locally disabled)

2 - (mouse push when 1)

3 - (mouse over when 1)

4 - RA Globally Disabled (locally enabled)

5 - (mouse push when 4)

6 - (mouse over when 4)

7 -

8 - Indicates that there are multiple automation lanes with different Read Automation states (tri-state)
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How Viewport Background works
Consider the following test images:

Control Bar / Modules / Transport / Viewport Background

We're going to use these to see how the element is used by Cakewalk for processes that take time, such as project load, importing 
audio files,  or exporting.

Using the default Mercury Transport:

During a large project load:

During a large project export:

Interesting factoid: the viewport is actually displayed as a separate application window, so if another Windows application has focus 
(like, say, the Windows screen clipping tool) you don't actually see the viewport appear.

Observations:

Transparent regions in the Viewport image are not respected. Cakewalk actually throws a black rectangle up and then overlays it with 
the viewport image. The underlying Transport image is obscured, not revealed.

In practice this means that if we want to make it appear as though the viewport is transparent, we need to reproduce the underlying 
Transport image in our viewport image. 

You can't make the "window" smaller than it is by default, because the horizontal black rectangle that appears during load will also 
overlay (and overlap) the image.
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FX Rack and ACT, in depth
by @StarshipKrupa

I just spent some time (time that I will never get back) with the images and colors in FX Rack. Here's what I found.

With no control surface enabled and the effect in its active, non-bypassed state

• Normal: FX Rack/Name Background cell 1

• Hovered: FX Rack/Open Plug-in UI cell 3

• Pressed: FX Rack/Open Plug-in UI cell 2

• Hovering the Bypass or Show Rack Menu button: FX Rack/Open Plug-in UI cell 1

With no control surface enabled and the effect in its bypassed state

• Normal: FX Rack/Name Background cell 2

• Hovered: FX Rack/Open Plug-in UI Bypassed cell 3

• Pressed: FX Rack/Open Plug-in UI Bypassed cell 2

• Hovering the Bypass or Show Rack Menu button: FX Rack/Open Plug-in UI Bypassed cell 1

This is pretty much as expected. Things get more complicated when  we enable a control surface. Once a control surface is enabled, 
there is another condition a plug-in effect can be in, which is having focus for the purposes of controlling it with the surface. A plug-in 
gets focus by having its UI opened, and keeps focus until the next plug-in UI is opened.

I'll start with a plug-in that does not have what I'll call "ACT Focus."

With a control surface enabled and the effect in its active, non-bypassed state

• Normal: FX Rack/Name Background cell 1

• Hovered: FX Rack/Open Plug-in UI cell 3

• Pressed: FX Rack/Open Plug-in UI (ACT Focus) cell 2

• Hovering the Bypass or Show Rack Menu button: FX Rack/Open Plug-in UI cell 1

With a control surface enabled and the effect in its bypassed state

• Normal: FX Rack/Name Background cell 2

• Hovered: FX Rack/Open Plug-in UI Bypassed cell 3

• Pressed: FX Rack/Open Plug-in UI (ACT Focus) cell 2

• Hovering the Bypass or Show Rack Menu button: FX Rack/Open Plug-in UI Bypassed cell 1

When the plug-in has ACT Focus, the behavior changes again as follows:

With ACT Focus and the effect in its active state

• Normal: FX Rack/Name Background (ACT Focus) cell 1

• Hovered: FX Rack/Open Plug-in UI (ACT Focus) cell 3

• Pressed: FX Rack/Open Plug-in UI (ACT Focus) cell 2

• Hovering the Bypass or Show Rack Menu button: FX Rack/Open Plug-in UI (ACT Focus) cell 1

With ACT Focus and the effect in its bypassed state

• Normal: FX Rack/Name Background (ACT Focus) cell 2

• Hovered: FX Rack/Open Plug-in UI Bypassed (ACT Focus) cell 3

• Pressed: FX Rack/Open Plug-in UI Bypassed (ACT Focus) cell 2

• Hovering the Bypass or Show Rack Menu button: FX Rack/Open Plug-in UI Bypassed (ACT Focus) cell 1
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Since these images are used as backgrounds for the text colors FX Rack/FX Name and FX Rack/Bypassed FX Name, care should be 
taken to make sure that whatever image is currently displayed should go well with those colors.
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Resizing Theme Elements for fun and profit
by @sjoens

Resizing a GUI image can have unintended and undesirable results. However, it can also be useful.

Resizing is not allowed using Import/Export but is possible when opening an image in an image editor from within Theme Editor. 

To set up an editor like Photoshop, open Theme Editor and click the Setup Wizard button in Tools menu. 

    1. Open a theme and double click an image. Photoshop opens. 

    2. Resize and save image. 

    3. Click OK in Theme Editor and save the theme.

Each image has its own size limitations giving it one of the following statuses:

    1. Stay within their assigned size with no affect on adjacent items.

    2. Overlap adjacent items covering them or being covered by them.

    3. Push adjacent items over to make room.

Example doubling the Snap To/By button size:

     Original Resized

This image covers the left side of the main Snap button image but slips under the images to the right and below it making it a status 2 
image.

Notes:

1. The top left corner cannot be repositioned so any change will be to the right and down.

2. Interactive images like buttons and knobs are Controller Hot Spots for those functions, so overlapping one with another may 
render one of the hot spots inactive.  Best to avoid overlapping!

3. To be safe, save changes to a new theme.

4. When loading a theme using resized images, CbB needs to be closed and reopened.
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Create cleaner looking text
by @sjoens

Text created in Photoshop is often blurred, smudged, or just plain YUK. You can use Cakewalk by Bandlab itself to generate text that 
looks much better!

At least two modules let you enter your own text, which you can then snapshot and paste into a theme element image, matching the 
GUI's typeface and size exactly.

For Normal text, use the Custom Module (or alternatively, the Console View Track Name)

(Track and Console View Name and Background can also be used)

1. Set text color you want in the Theme Editor (Alternative Text #2)

2. Choose a theme that has an appropriate color for the text background, or repaint the Custom Button background to the desired color

3. Run Cakewalk By BandLab, and right-click any Custom button and type the desired text

4. Use Windows Snipping Tool to copy and paste into your image editor.

For Bold text, use the Markers module, or perhaps the Track View Track Name, where you can enter long strings of text if you need to.

1. Set the text color you want in the Theme Editor (Alternative Text #2 or Track Name color)

2. Chose a theme with a light or dark button background, or set the color appropriately

3. In Cakewalk by Bandlab, click the + button and type your new text

4. Use Windows Snipping Tool 

Shrinking copied text to 75% still looks good.

Just remember to re-rename the buttons or delete the markers when you're done.
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